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1.  Copyright Notice
© Copyright 2019 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are
the property of Esko Software BV. The material, information and instructions are provided
on an AS IS basis without warranty of any kind. There are no warranties granted or extended
by this document. Furthermore Esko Software BV does not warrant, guarantee or make any
representations regarding the use, or the results of the use of the software or the information
contained herein. Esko Software BV shall not be liable for any direct, indirect, consequential or
incidental damages arising out of the use or inability to use the software or the information
contained herein.

The information contained herein is subject to change without notice. Revisions may be issued
from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system,
or published, in any form or in any way, electronically, mechanically, by print, photoprint,
microfilm or any other means without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®
 Colors displayed in the software application or in the user documentation may

not match PANTONE-identified standards. Consult current PANTONE Color Publications for
accurate color. PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. ©

Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to
distribute for use only in combination with Studio Visualizer. PANTONE Color Data and/or
Software shall not be copied onto another disk or into memory unless as part of the execution
of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org).
All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk
Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP
are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign,
PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the
United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark
Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

1.1.  Third party license information

This product includes lzw-ab.

    Copyright (c) David Bryant
    All rights reserved.

    Redistribution and use in source and binary forms, with or without
    modification, are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
    * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the
      documentation and/or other materials provided with the distribution.
    * Neither the name of Conifer Software nor the names of its contributors
      may be used to endorse or promote products derived from this software
      without specific prior written permission.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
    AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
    IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
    ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
    ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
    DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
    SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
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    CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
    OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
    OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes Bonjour SDK.

   Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.
  
   Redistribution and use in source and binary forms, with or without 
   modification, are permitted provided that the following conditions are met:
  
   1.  Redistributions of source code must retain the above copyright notice, 
       this list of conditions and the following disclaimer. 
   2.  Redistributions in binary form must reproduce the above copyright notice, 
       this list of conditions and the following disclaimer in the documentation 
       and/or other materials provided with the distribution. 
   3.  Neither the name of Apple Computer, Inc. ("Apple") nor the names of its 
       contributors may be used to endorse or promote products derived from this 
       software without specific prior written permission. 
  
   THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY 
   EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
   WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
   DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
   DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
   (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
   LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
   ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
   (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
   SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes Botan.

      Copyright (C) 1999-2009 Jack Lloyd
                    2001 Peter J Jones
                    2004-2007 Justin Karneges
                    2005 Matthew Gregan
                    2005-2006 Matt Johnston
                    2006 Luca Piccarreta
                    2007 Yves Jerschow
                    2007-2008 FlexSecure GmbH
                    2007-2008 Technische Universitat Darmstadt
                    2007-2008 Falko Strenzke
                    2007-2008 Martin Doering
                    2007 Manuel Hartl
                    2007 Christoph Ludwig
                    2007 Patrick Sona
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are
      met:

      1. Redistributions of source code must retain the above copyright
      notice, this list of conditions, and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
      notice, this list of conditions, and the following disclaimer in the
      documentation and/or other materials provided with the distribution.

      THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR
      IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
      WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
      ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S) OR CONTRIBUTOR(S) BE
      LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
      CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
      SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
      BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
      WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
      OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
      IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------
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This product includes cereal.

    Copyright (c) 2014, Randolph Voorhies, Shane Grant
    All rights reserved.

    Redistribution and use in source and binary forms, with or without
    modification, are permitted provided that the following conditions are met:
        * Redistributions of source code must retain the above copyright
        notice, this list of conditions and the following disclaimer.
        * Redistributions in binary form must reproduce the above copyright
        notice, this list of conditions and the following disclaimer in the
        documentation and/or other materials provided with the distribution.
        * Neither the name of cereal nor the
        names of its contributors may be used to endorse or promote products
        derived from this software without specific prior written permission.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
    ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
    WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
    DISCLAIMED. IN NO EVENT SHALL RANDOLPH VOORHIES OR SHANE GRANT BE LIABLE FOR ANY
    DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
    (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
    LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
    ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
    (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
    SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
  
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
    ColourKit Profiler Suite (www.colourprofiling.com)
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and
    SWOP(R) are all registered trademarks of IDEAlliance(C).
    
------------------------------------------------------------

This product includes PANTONE Color Libraries.

    PANTONE® and other Pantone trademarks are the property of Pantone LLC.
    Pantone is a wholly owned subsidiary of X-Rite, Incorporated.
    
------------------------------------------------------------

This product includes curl.

      Copyright (c) 1996 - 2015, Daniel Stenberg, <daniel@haxx.se>.
      All rights reserved.

      Permission to use, copy, modify, and distribute this software for any purpose
      with or without fee is hereby granted, provided that the above copyright
      notice and this permission notice appear in all copies.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
      FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
      NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
      DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
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      OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
      OR OTHER DEALINGS IN THE SOFTWARE.

      Except as contained in this notice, the name of a copyright holder shall not
      be used in advertising or otherwise to promote the sale, use or other dealings
      in this Software without prior written authorization of the copyright holder.
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes FCollada.

      Copyright 2006 Feeling Software. All rights reserved.

      Copyright 2005-2006 Feeling Software and
      Copyright 2005-2006 Autodesk Media Entertainment.

      Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

      Permission is hereby granted, free of charge, to any person obtaining a copy
      of this software and associated documentation files (the "Software"), to deal
      in the Software without restriction, including without limitation the rights
      to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
      copies of the Software, and to permit persons to whom the Software is fur-
      nished to do so, subject to the following conditions:

      The above copyright notice and this permission notice shall be included in
      all copies or substantial portions of the Software.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
      NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
      AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
      LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
      OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
      THE SOFTWARE.
    
------------------------------------------------------------

This product includes FreeType.

    Portions of this software are copyright (C) 2014 The FreeType
    Project (www.freetype.org) licensed under the Freetype License.
    All rights reserved.
    
------------------------------------------------------------

This product includes GLEW: The OpenGL Extension Wrangler Library.

The OpenGL Extension Wrangler Library
Copyright (C) 2002-2007, Milan Ikits <milan ikits[]ieee org>
Copyright (C) 2002-2007, Marcelo E. Magallon <mmagallo[]debian org>
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Copyright (C) 2002, Lev Povalahev
All rights reserved.

Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, 
  this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, 
  this list of conditions and the following disclaimer in the documentation 
  and/or other materials provided with the distribution.
* The name of the author may be used to endorse or promote products 
  derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Mesa 3-D graphics library
Version:  7.0

Copyright (C) 1999-2007  Brian Paul   All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL
BRIAN PAUL BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2007 The Khronos Group Inc.

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and/or associated documentation files (the
"Materials"), to deal in the Materials without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Materials, and to
permit persons to whom the Materials are furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Materials.

THE MATERIALS ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
MATERIALS OR THE USE OR OTHER DEALINGS IN THE MATERIALS.
  
------------------------------------------------------------

This product includes gSOAP.

      EXHIBIT B.
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      Part of the software embedded in this product is gSOAP software.
      Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen,
 Genivia inc. All Rights Reserved.

      THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS
 OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
 MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
 THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
 OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
 ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
 NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
 ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes ICU.

      Copyright (c) 1995-2014 International Business Machines Corporation and others
      All rights reserved.

      Permission is hereby granted, free of charge, to any person obtaining a copy of
      this software and associated documentation files (the "Software"), to deal in the
      Software without restriction, including without limitation the rights to use,
      copy, modify, merge, publish, distribute, and/or sell copies of the Software, and
      to permit persons to whom the Software is furnished to do so, provided that the
      above copyright notice(s) and this permission notice appear in all copies of the
      Software and that both the above copyright notice(s) and this permission notice
      appear in supporting documentation.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
      FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
      SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
      CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
      WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
      CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
      WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes ilmbase.

      Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm
      Entertainment Company Ltd.  Portions contributed and copyright held by
      others as indicated.  All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are
      met:

          * Redistributions of source code must retain the above
            copyright notice, this list of conditions and the following
            disclaimer.

          * Redistributions in binary form must reproduce the above
            copyright notice, this list of conditions and the following
            disclaimer in the documentation and/or other materials provided with
            the distribution.

          * Neither the name of Industrial Light & Magic nor the names of
            any other contributors to this software may be used to endorse or
            promote products derived from this software without specific prior
            written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
      IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
      THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
      CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
      EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
      PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
      PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
      LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
      NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
      SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.    
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------------------------------------------------------------

This product includes IP*Works!.

      Copyright (c) 2013 /n software inc. - All rights reserved.

      DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT
      WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
      MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE
      SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING
      THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN
      TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE
      ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED
      BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS
      EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS
      WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE.  FURTHER, THE
      LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR
      INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS
      REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES,
      AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE
      SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE
      COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL
      DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY
 DISCLAIM
      ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

      LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE
      LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE
 SHALL
      BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE.
      /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY
      DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED
 SOFTWARE,
      OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N
 SOFTWARE,
      ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE,
      PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL
 DAMAGES
      OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES,
      HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR
      INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N
 SOFTWARE,
      ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE
      POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL
 OR
      CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF
      LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.
    
------------------------------------------------------------

This product includes IP*Works! SSL.

      Copyright (c) 2013 /n software inc. - All rights reserved.

      DISCLAIMER OF WARRANTY. THE LICENSED SOFTWARE IS PROVIDED "AS IS" WITHOUT
      WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF
      MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FURTHER, /N SOFTWARE
      SPECIFICALLY DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING
      THE USE, OR THE RESULTS OF THE USE, OF THE LICENSED SOFTWARE OR DOCUMENTATION IN
      TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE
      ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE LICENSED SOFTWARE IS ASSUMED
      BY YOU. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY /N SOFTWARE OR ITS
      EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS
      WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE.  FURTHER, THE
      LICENSED SOFTWARE IS NOT FAULT-TOLERANT AND IS NOT DESIGNED, MANUFACTURED OR
      INTENDED FOR USE OR RESALE AS ON-LINE CONTROL EQUIPMENT IN HAZARDOUS ENVIRONMENTS
      REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF NUCLEAR FACILITIES,
      AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, DIRECT LIFE
      SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF THE LICENSED SOFTWARE
      COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL
      DAMAGE ("HIGH RISK ACTIVITIES"). /N SOFTWARE AND ITS SUPPLIERS SPECIFICALLY
 DISCLAIM
      ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR HIGH RISK ACTIVITIES.

      LIMITATION ON LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE
      LIABILITY OF /N SOFTWARE, IF ANY, FOR DAMAGES RELATING TO THE LICENSED SOFTWARE
 SHALL
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      BE LIMITED TO THE ACTUAL AMOUNTS PAID BY YOU FOR SUCH LICENSED SOFTWARE.
      /N SOFTWARE'S LICENSORS AND THEIR SUPPLIERS SHALL HAVE NO LIABILITY TO YOU FOR ANY
      DAMAGES SUFFERED BY YOU OR ANY THIRD PARTY AS A RESULT OF USING THE LICENSED
 SOFTWARE,
      OR ANY PORTION THEREOF. NOTWITHSTANDING THE FOREGOING, IN NO EVENT SHALL /N
 SOFTWARE,
      ITS LICENSORS, OR ANY OF THEIR RESPECTIVE SUPPLIERS BE LIABLE FOR ANY LOST REVENUE,
      PROFIT OR DATA, OR FOR INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL
 DAMAGES
      OF ANY CHARACTER, INCLUDING, WITHOUT LIMITATION, ANY COMMERCIAL DAMAGES OR LOSSES,
      HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OR
      INABILITY TO USE THE LICENSED SOFTWARE, OR ANY PORTION THEREOF, EVEN IF /N
 SOFTWARE,
      ITS LICENSORS AND/OR ANY OF THEIR RESPECTIVE SUPPLIERS HAVE BEEN INFORMED OF THE
      POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION OF INCIDENTAL
 OR
      CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY. EACH EXCLUSION OF
      LIMITATION IS INTENDED TO BE SEPARATE AND THEREFORE SEVERABLE.
    
------------------------------------------------------------

This product includes JBIG2Lib.

    Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.
    
------------------------------------------------------------

This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
      All Rights Reserved.
      
      This software is based in part on the work of the Independent JPEG Group.
------------------------------------------------------------

This product includes Little CMS.

    Little CMS
    Copyright (c) 1998-2011 Marti Maria Saguer

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is
    furnished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
    FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes leptonica.

 -  Copyright (C) 2001-2016 Leptonica.  All rights reserved.
 -
 -  Redistribution and use in source and binary forms, with or without
 -  modification, are permitted provided that the following conditions
 -  are met:
 -  1. Redistributions of source code must retain the above copyright
 -     notice, this list of conditions and the following disclaimer.
 -  2. Redistributions in binary form must reproduce the above
 -     copyright notice, this list of conditions and the following
 -     disclaimer in the documentation and/or other materials
 -     provided with the distribution.
 -
 -  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
 -  ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
 -  LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
 -  A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL ANY
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 -  CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
 -  EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
 -  PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
 -  PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
 -  OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
 -  NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
 -  SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes libpng.

      Copyright (c) 2000-2002 Glenn Randers-Pehrson

      The PNG Reference Library is supplied "AS IS".  The Contributing Authors
      and Group 42, Inc. disclaim all warranties, expressed or implied,
      including, without limitation, the warranties of merchantability and of
      fitness for any purpose.  The Contributing Authors and Group 42, Inc.
      assume no liability for direct, indirect, incidental, special, exemplary,
      or consequential damages, which may result from the use of the PNG
      Reference Library, even if advised of the possibility of such damage.
      There is no warranty against interference with your enjoyment of the
      library or against infringement.  There is no warranty that our
      efforts or the library will fulfill any of your particular purposes
      or needs.  This library is provided with all faults, and the entire
      risk of satisfactory quality, performance, accuracy, and effort is with
      the user.
    
------------------------------------------------------------

This product includes libxml2.

    Copyright (C) 1998-2012 Daniel Veillard.  All Rights Reserved.

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is fur-
    nished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
    NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes openexr.

      Copyright (c) 2006, Industrial Light & Magic, a division of Lucasfilm
      Entertainment Company Ltd.  Portions contributed and copyright held by
      others as indicated.  All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are
      met:

          * Redistributions of source code must retain the above
            copyright notice, this list of conditions and the following
            disclaimer.

          * Redistributions in binary form must reproduce the above
            copyright notice, this list of conditions and the following
            disclaimer in the documentation and/or other materials provided with
            the distribution.

          * Neither the name of Industrial Light & Magic nor the names of
            any other contributors to this software may be used to endorse or
            promote products derived from this software without specific prior
            written permission.
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      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS
      IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
      THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
      CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
      EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
      PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
      PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
      LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
      NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
      SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.    
    
------------------------------------------------------------

This product includes OpenJDK.
 
The GNU General Public License (GPL)

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license
document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share
and change it.  By contrast, the GNU General Public License is intended to
guarantee your freedom to share and change free software--to make sure the
software is free for all its users.  This General Public License applies to
most of the Free Software Foundation's software and to any other program whose
authors commit to using it.  (Some other Free Software Foundation software is
covered by the GNU Library General Public License instead.) You can apply it to
your programs, too.

When we speak of free software, we are referring to freedom, not price.  Our
General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for this service if you wish),
that you receive source code or can get it if you want it, that you can change
the software or use pieces of it in new free programs; and that you know you
can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny
you these rights or to ask you to surrender the rights.  These restrictions
translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for
a fee, you must give the recipients all the rights that you have.  You must
make sure that they, too, receive or can get the source code.  And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2)
offer you this license which gives you legal permission to copy, distribute
and/or modify the software.

Also, for each author's protection and ours, we want to make certain that
everyone understands that there is no warranty for this free software.  If the
software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced
by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents.  We
wish to avoid the danger that redistributors of a free program will
individually obtain patent licenses, in effect making the program proprietary.
To prevent this, we have made it clear that any patent must be licensed for
everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification
follow.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice
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placed by the copyright holder saying it may be distributed under the terms of
this General Public License.  The "Program", below, refers to any such program
or work, and a "work based on the Program" means either the Program or any
derivative work under copyright law: that is to say, a work containing the
Program or a portion of it, either verbatim or with modifications and/or
translated into another language.  (Hereinafter, translation is included
without limitation in the term "modification".) Each licensee is addressed as
"you".

Activities other than copying, distribution and modification are not covered by
this License; they are outside its scope.  The act of running the Program is
not restricted, and the output from the Program is covered only if its contents
constitute a work based on the Program (independent of having been made by
running the Program).  Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as
you receive it, in any medium, provided that you conspicuously and
appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License
and to the absence of any warranty; and give any other recipients of the
Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may
at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus
forming a work based on the Program, and copy and distribute such modifications
or work under the terms of Section 1 above, provided that you also meet all of
these conditions:

    a) You must cause the modified files to carry prominent notices stating
    that you changed the files and the date of any change.

    b) You must cause any work that you distribute or publish, that in whole or
    in part contains or is derived from the Program or any part thereof, to be
    licensed as a whole at no charge to all third parties under the terms of
    this License.

    c) If the modified program normally reads commands interactively when run,
    you must cause it, when started running for such interactive use in the
    most ordinary way, to print or display an announcement including an
    appropriate copyright notice and a notice that there is no warranty (or
    else, saying that you provide a warranty) and that users may redistribute
    the program under these conditions, and telling the user how to view a copy
    of this License.  (Exception: if the Program itself is interactive but does
    not normally print such an announcement, your work based on the Program is
    not required to print an announcement.)

These requirements apply to the modified work as a whole.  If identifiable
sections of that work are not derived from the Program, and can be reasonably
considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate
works.  But when you distribute the same sections as part of a whole which is a
work based on the Program, the distribution of the whole must be on the terms
of this License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your
rights to work written entirely by you; rather, the intent is to exercise the
right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the
Program (or with a work based on the Program) on a volume of a storage or
distribution medium does not bring the other work under the scope of this
License.

3. You may copy and distribute the Program (or a work based on it, under
Section 2) in object code or executable form under the terms of Sections 1 and
2 above provided that you also do one of the following:

    a) Accompany it with the complete corresponding machine-readable source
    code, which must be distributed under the terms of Sections 1 and 2 above
    on a medium customarily used for software interchange; or,

    b) Accompany it with a written offer, valid for at least three years, to
    give any third party, for a charge no more than your cost of physically
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    performing source distribution, a complete machine-readable copy of the
    corresponding source code, to be distributed under the terms of Sections 1
    and 2 above on a medium customarily used for software interchange; or,

    c) Accompany it with the information you received as to the offer to
    distribute corresponding source code.  (This alternative is allowed only
    for noncommercial distribution and only if you received the program in
    object code or executable form with such an offer, in accord with
    Subsection b above.)

The source code for a work means the preferred form of the work for making
modifications to it.  For an executable work, complete source code means all
the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation
of the executable.  However, as a special exception, the source code
distributed need not include anything that is normally distributed (in either
source or binary form) with the major components (compiler, kernel, and so on)
of the operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy
from a designated place, then offering equivalent access to copy the source
code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as
expressly provided under this License.  Any attempt otherwise to copy, modify,
sublicense or distribute the Program is void, and will automatically terminate
your rights under this License.  However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it.
However, nothing else grants you permission to modify or distribute the Program
or its derivative works.  These actions are prohibited by law if you do not
accept this License.  Therefore, by modifying or distributing the Program (or
any work based on the Program), you indicate your acceptance of this License to
do so, and all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program),
the recipient automatically receives a license from the original licensor to
copy, distribute or modify the Program subject to these terms and conditions.
You may not impose any further restrictions on the recipients' exercise of the
rights granted herein.  You are not responsible for enforcing compliance by
third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues), conditions
are imposed on you (whether by court order, agreement or otherwise) that
contradict the conditions of this License, they do not excuse you from the
conditions of this License.  If you cannot distribute so as to satisfy
simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all.
For example, if a patent license would not permit royalty-free redistribution
of the Program by all those who receive copies directly or indirectly through
you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any
particular circumstance, the balance of the section is intended to apply and
the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or
other property right claims or to contest validity of any such claims; this
section has the sole purpose of protecting the integrity of the free software
distribution system, which is implemented by public license practices.  Many
people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to
distribute software through any other system and a licensee cannot impose that
choice.

This section is intended to make thoroughly clear what is believed to be a
consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain
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countries either by patents or by copyrighted interfaces, the original
copyright holder who places the Program under this License may add an explicit
geographical distribution limitation excluding those countries, so that
distribution is permitted only in or among countries not thus excluded.  In
such case, this License incorporates the limitation as if written in the body
of this License.

9. The Free Software Foundation may publish revised and/or new versions of the
General Public License from time to time.  Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems
or concerns.

Each version is given a distinguishing version number.  If the Program
specifies a version number of this License which applies to it and "any later
version", you have the option of following the terms and conditions either of
that version or of any later version published by the Free Software Foundation.
If the Program does not specify a version number of this License, you may
choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs
whose distribution conditions are different, write to the author to ask for
permission.  For software which is copyrighted by the Free Software Foundation,
write to the Free Software Foundation; we sometimes make exceptions for this.
Our decision will be guided by the two goals of preserving the free status of
all derivatives of our free software and of promoting the sharing and reuse of
software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible
use to the public, the best way to achieve this is to make it free software
which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program.  It is safest to attach
them to the start of each source file to most effectively convey the exclusion
of warranty; and each file should have at least the "copyright" line and a
pointer to where the full notice is found.

    One line to give the program's name and a brief idea of what it does.

    Copyright (C) <year> <name of author>

    This program is free software; you can redistribute it and/or modify it
    under the terms of the GNU General Public License as published by the Free
    Software Foundation; either version 2 of the License, or (at your option)
    any later version.

    This program is distributed in the hope that it will be useful, but WITHOUT
    ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or
    FITNESS FOR A PARTICULAR PURPOSE.  See the GNU General Public License for
    more details.

    You should have received a copy of the GNU General Public License along
    with this program; if not, write to the Free Software Foundation, Inc.,
    51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.
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Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it
starts in an interactive mode:

    Gnomovision version 69, Copyright (C) year name of author Gnomovision comes
    with ABSOLUTELY NO WARRANTY; for details type 'show w'.  This is free
    software, and you are welcome to redistribute it under certain conditions;
    type 'show c' for details.

The hypothetical commands 'show w' and 'show c' should show the appropriate
parts of the General Public License.  Of course, the commands you use may be
called something other than 'show w' and 'show c'; they could even be
mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your school,
if any, to sign a "copyright disclaimer" for the program, if necessary.  Here
is a sample; alter the names:

    Yoyodyne, Inc., hereby disclaims all copyright interest in the program
    'Gnomovision' (which makes passes at compilers) written by James Hacker.

    signature of Ty Coon, 1 April 1989

    Ty Coon, President of Vice

This General Public License does not permit incorporating your program into
proprietary programs.  If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library.  If this is what you want to do, use the GNU Library General Public
License instead of this License.

"CLASSPATH" EXCEPTION TO THE GPL

Certain source files distributed by Oracle America and/or its affiliates are
subject to the following clarification and special exception to the GPL, but
only where Oracle has expressly included in the particular source file's header
the words "Oracle designates this particular file as subject to the "Classpath"
exception as provided by Oracle in the LICENSE file that accompanied this code."

    Linking this library statically or dynamically with other modules is making
    a combined work based on this library.  Thus, the terms and conditions of
    the GNU General Public License cover the whole combination.

    As a special exception, the copyright holders of this library give you
    permission to link this library with independent modules to produce an
    executable, regardless of the license terms of these independent modules,
    and to copy and distribute the resulting executable under terms of your
    choice, provided that you also meet, for each linked independent module,
    the terms and conditions of the license of that module.  An independent
    module is a module which is not derived from or based on this library.  If
    you modify this library, you may extend this exception to your version of
    the library, but you are not obligated to do so.  If you do not wish to do
    so, delete this exception statement from your version.
    
------------------------------------------------------------

This product includes OpenJPEG.

        The copyright in this software is being made available under the 2-clauses
        BSD License, included below. This software may be subject to other third
        party and contributor rights, including patent rights, and no such rights
        are granted under this license.
       
        Copyright (c) 2002-2014, Universite catholique de Louvain (UCL), Belgium
        Copyright (c) 2002-2014, Professor Benoit Macq
        Copyright (c) 2003-2014, Antonin Descampe
        Copyright (c) 2003-2009, Francois-Olivier Devaux
        Copyright (c) 2005, Herve Drolon, FreeImage Team
        Copyright (c) 2002-2003, Yannick Verschueren
        Copyright (c) 2001-2003, David Janssens
        Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
        Copyright (c) 2012, CS Systemes d'Information, France
       
        All rights reserved.
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        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions
        are met:
        1. Redistributions of source code must retain the above copyright
           notice, this list of conditions and the following disclaimer.
        2. Redistributions in binary form must reproduce the above copyright
           notice, this list of conditions and the following disclaimer in the
           documentation and/or other materials provided with the distribution.
       
        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS `AS IS'
        AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
        IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
        ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
        LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
        CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
        SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
        INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
        CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
        ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
        POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (c) 1998-2017 The OpenSSL Project.  All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:

      1. Redistributions of source code must retain the above copyright
         notice, this list of conditions and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in
         the documentation and/or other materials provided with the
         distribution.

      3. All advertising materials mentioning features or use of this
         software must display the following acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

      4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
         endorse or promote products derived from this software without
         prior written permission. For written permission, please contact
         openssl-core@openssl.org.

      5. Products derived from this software may not be called "OpenSSL"
         nor may "OpenSSL" appear in their names without prior written
         permission of the OpenSSL Project.

      6. Redistributions of any form whatsoever must retain the following
         acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit (http://www.openssl.org/)"

      THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
      EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
      ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
      NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
      LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
      STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
      OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
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      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:
      1. Redistributions of source code must retain the copyright
         notice, this list of conditions and the following disclaimer.
      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in the
         documentation and/or other materials provided with the distribution.
      3. All advertising materials mentioning features or use of this software
         must display the following acknowledgement:
         "This product includes cryptographic software written by
         Eric Young (eay@cryptsoft.com)"
         The word 'cryptographic' can be left out if the rouines from the library
         being used are not cryptographic related :-).
      4. If you include any Windows specific code (or a derivative thereof) from
         the apps directory (application code) you must include an acknowledgement:
         "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

      THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
      ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
      FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
      DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
      OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
      OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
      SUCH DAMAGE.
    
------------------------------------------------------------

This product includes PCRE.

  Copyright (c) 1997-2016 University of Cambridge
  All rights reserved.

  Copyright(c) 2010-2016 Zoltan Herczeg
  All rights reserved.

  Copyright(c) 2009-2016 Zoltan Herczeg
  All rights reserved.

  Redistribution and use in source and binary forms, with or without
  modification, are permitted provided that the following conditions are met:

      * Redistributions of source code must retain the above copyright notice,
        this list of conditions and the following disclaimer.

      * Redistributions in binary form must reproduce the above copyright
        notice, this list of conditions and the following disclaimer in the
        documentation and/or other materials provided with the distribution.

      * Neither the name of the University of Cambridge nor the names of any
        contributors may be used to endorse or promote products derived from this
        software without specific prior written permission.

  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
  AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
  IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
  ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
  LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
  CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
  SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
  INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
  CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
  ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
  POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes patented technology.

      This product and use of this product is under license from Markzware
      under U.S. Patent No. 5,963,641.
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------------------------------------------------------------

This product includes Qt.

       The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).
     
    
------------------------------------------------------------

This product includes QtMigration.

        Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
            of its contributors may be used to endorse or promote products derived
            from this software without specific prior written permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."
   

    
------------------------------------------------------------

This product includes svgio.

 Copyright Oleg Maximenko 2014.
 Distributed under the Boost Software License, Version 1.0.
    
------------------------------------------------------------

This product includes tesseract.

  Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF

22



1Dynamic Barcodes for Adobe Illustrator

      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes XercesC.

    NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this
 case for the Apache Xerces distribution.

    This product includes software developed by
    The Apache Software Foundation (http://www.apache.org/).

    Portions of this software were originally based on the following:
     - software copyright (c) 1999, IBM Corporation., http://www.ibm.com.
    
------------------------------------------------------------

This product includes XMP Toolkit.

      Copyright (c) 1999 - 2010, Adobe Systems Incorporated
      All rights reserved.

      Redistribution and use in source and binary forms, with or
      without modification, are permitted provided that the following
      conditions are met:

      * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
      * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the documentation
      and/or other materials provided with the distribution.
      * Neither the name of Adobe Systems Incorporated, nor the names of its
      contributors may be used to endorse or promote products derived from this
      software without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
      "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
      LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
      A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
      CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
      EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
      PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
      PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
      LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
      NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
      SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes xxHash.

    xxHash Library
    Copyright (c) 2012-2014, Yann Collet
    All rights reserved.

    Redistribution and use in source and binary forms, with or without modification,
    are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice, this
    list of conditions and the following disclaimer.

    * Redistributions in binary form must reproduce the above copyright notice, this
    list of conditions and the following disclaimer in the documentation and/or
    other materials provided with the distribution.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
    ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
    WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
    DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR
    ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
    (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
    LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
    ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
    (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
    SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
  

23



1 Dynamic Barcodes for Adobe Illustrator

------------------------------------------------------------

This product includes zlib.

 (C) 1995-2017 Jean-loup Gailly and Mark Adler

  This software is provided 'as-is', without any express or implied
  warranty.  In no event will the authors be held liable for any damages
  arising from the use of this software.

  Permission is granted to anyone to use this software for any purpose,
  including commercial applications, and to alter it and redistribute it
  freely, subject to the following restrictions:

  1. The origin of this software must not be misrepresented; you must not
     claim that you wrote the original software. If you use this software
     in a product, an acknowledgment in the product documentation would be
     appreciated but is not required.
  2. Altered source versions must be plainly marked as such, and must not be
     misrepresented as being the original software.
  3. This notice may not be removed or altered from any source distribution.

  Jean-loup Gailly        Mark Adler
  jloup@gzip.org          madler@alumni.caltech.edu
    
------------------------------------------------------------

This product includes ZXing C++ Library.

      --------------------------------------------------------------------------------
      NOTICES FOR C++ Big Integer Library
      --------------------------------------------------------------------------------

      I, Matt McCutchen, the sole author of the original Big Integer
      Library, waive my copyright to it, placing it in the public domain.
      The library comes with absolutely no warranty.
  
------------------------------------------------------------
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2.  What is a barcode ?
A barcode is a machine-readable representation of information in a visual format on a surface.
Barcodes can be read by optical scanners, allowing quick and easy identification of all kind of
goods.

Originally barcodes stored data in the widths and spacings of printed parallel lines, but today
they also come in patterns of dots, concentric circles, and hidden in images.

The information contained in a barcode varies from numbers to complete ASCII texts. The
drive to encode ever more information in combination with the space requirements of simple
barcodes led to the development of matrix barcodes or 2D barcode, which do not consist of
bars but rather a grid of square cells.

Barcodes are just the visible part of often quite large systems frequently referred to as
automated identification systems. These systems are increasingly proving to be some of the
most cost-effective management tools, since they enable organizations to keep track of their
goods and stocks in all kinds of situations in a fast, accurate and efficient way.

With the Dynamic Barcodes plug-in, you can add a dynamic barcode to your document without
leaving your application. Dynamic means that your barcode settings can be changed later on,
even after you saved, closed and reopened your document.
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3.  Getting Started with Dynamic
Barcodes

To introduce you to Dynamic Barcodes, here is how to make your first barcode in four simple
steps.

1. Create a CMYK Illustrator document and go to Windows > Esko > Dynamic Barcodes.

This opens the Dynamic Barcodes dialog.

 

 
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill

style and no stroke.
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3. Enter the barcode parameters (Barcode Type, numeric Code...) in the Dynamic Barcodes
dialog.

For example, for an EAN 13 barcode, select EAN 13 as Barcode Type and enter a 13 digit
Code.

 

 
4. Click the Create button and Dynamic Barcodes will generate the barcode in your document.
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4.  Using Dynamic Barcodes in Unlicensed
Mode

If you don't have a license for the Dynamic Barcodes plug-in, you still use it in unlicensed mode
to perform limited operations. You can:

• Open documents containing barcodes created by Dynamic Barcodes without warning
messages.

• Create barcode placeholders (with no data in them) in your design.

See Creating a Barcode Placeholder Quickly on page 34.

You can also use the regular Illustrator functions to:

• change the barcode's position in your document,

• rotate it by multiples of 90 degrees (using Object > Transform > Rotate),

Tip:  You can rotate several barcodes at once.

• change its fill color (it is not possible to apply a stroke),

Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),

• not too light (or the barcode might be difficult to scan).

• copy and paste it.

• delete it.
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5.  Dynamic Barcodes Basics

5.1.  Creating a Barcode

1. Create a CMYK Illustrator document and go to Windows > Esko > Dynamic Barcodes.

You can also use the Command + Option + 4 shortcut on Mac, or the CTRL + Alt + 4
shortcut on PC.

This opens the Dynamic Barcodes dialog.
 

 
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill

style and no stroke.

Dynamic Barcodes creates bars by generating rectangular objects and assigning the current
fill style to them.
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Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),
• not too light (or the barcode might be difficult to scan).

3. In the Dynamic Barcodes dialog, select your Barcode Type.
4. Enter a Rotation angle for your barcode, or use one of the rotation buttons. Choose the

Orientation of your barcode using one of the buttons or by entering an angle.
5. Enter the barcode's data in the Code field. For most barcodes, you can choose to also show

this data as a (human-readable) number.

Attention:  Make sure the barcode data you enter is valid for the barcode type you
chose. If it isn't, a warning / error will pop up.
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Note:  If you enter a wrong check digit, Dynamic Barcodes can fix it automatically for you.
 

 

6. To fill in other parameters specific to the barcode type you chose, open the Additional
parameters section and see Barcode Types on page 54.
 

 
7. Click the Create button.
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• If you have the boostX plug-in installed, Dynamic Barcodes generates your barcode at
the intersection of the boostX crosshair.

• If you don't have the boostX plug-in installed, Dynamic Barcodes generates your barcode
in the center of the view.

 

 

5.2.  Editing a Barcode
With Dynamic Barcodes, you can also edit existing barcodes.

1. Open the Dynamic Barcodes.
2. Select the barcode to edit in your Illustrator document.
3. Change its parameters as you wish in the Dynamic Barcodes dialog.

Note:

If you change the Barcode Type and the previous Code is not valid for this barcode type,
Dynamic Barcodes will reset it to the (first) default code for this barcode type.

This is the default code used for placeholder barcodes; you can see it in the preset barcodes
dialog (see Previewing and Creating a Barcode Placeholder on page 35).

You can then either:

• enter your own valid code,

• use this default code to create a placeholder barcode (see Creating a Barcode Placeholder
Quickly on page 34).

4. Click the Apply button to apply your changes to the barcode.

5.3.  Setting Barcode Parameters to Default

• To reset all the parameters of the selected barcode to default, click the palette menu 
in the top right corner of the Dynamic Barcodes dialog then click Set Default Parameters.
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Note:  The Bar Width Reduction, Device Compensation and Snap Bars to Output
Resolution parameters are not reverted to the defaults, since these parameters are related
to the press settings, and not related to the selected barcode.

5.4.  Barcode Placeholders

If you don't have the exact data to encode in your barcode yet, you can already create a
barcode placeholder in your design.

This placeholder will have the correct symbol type for the barcode type you choose, but will
only contain “empty” or “default” data (for example 0000000000000 for EAN 13).
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5.4.1.  Creating a Barcode Placeholder Quickly

1. Open the Dynamic Barcodes dialog from Windows > Esko > Dynamic Barcodes.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill

style and no stroke.
 

 

Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),

• not too light (or the barcode might be difficult to scan).

3. In the Dynamic Barcodes dialog, select your Barcode Type.

The Code field is automatically filled out with a nul / default value that has the correct
number of digits for your Barcode Type (for example 0000000000000 for EAN 13).
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4. Click the Create button to create your barcode placeholder.

 

 

Note:  You can also create a barcode placeholder in unlicensed mode (see Using Dynamic
Barcodes in Unlicensed Mode on page 28).

5.4.2.  Previewing and Creating a Barcode Placeholder

You can use Dynamic Barcodes to preview different barcode types before creating your
barcode placeholder.

1. Open the Dynamic Barcodes dialog from Window > Esko > Dynamic Barcodes.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill

style and no stroke.
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Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),

• not too light (or the barcode might be difficult to scan).

3.
In the Dynamic Barcodes dialog, click the Pre-set barcodes icon .

This opens the Select Barcode dialog.

 

 
4. Select your Barcode Type on the right to see a Preview of it on the left.
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Note:  This shows previews of barcode placeholders. Your actual barcode (with data and
specific parameters affecting its size) may look slightly different. For more information on
barcode parameters, see Barcode Types on page 54.

5. If your barcode data can have several possible lengths (for example EAN 13 can have 13, 15
or 18 digits), choose the length you want to preview in Code Preset.
 

 
6. If your barcode can have a Composite Component (some GS1 barcodes), you can choose

to preview it with or without that component.
 

 
7. Click OK to use the preview parameters (Barcode Type, Code Preset and Composite

Component as applicable) in the Dynamic Barcodes dialog and close the Select Barcode
dialog.

8. In the Dynamic Barcodes dialog, click the Create button to create your barcode
placeholder.
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5.5.  Expand
By using the Expand function, you can replace a barcode by regular objects (rectangles, text, …)
in a group, without any barcode information.

Note:  Adobe Illustrator also contains an "Expand" function. However, since this does not
remove the barcode metadata, the barcode remains editable.

1. Select the barcode you want to expand
2. From the fly-out menu of the Dynamic Barcodes panel, select Expand

Note:  Barcodes used by Dynamic Marks and Dynamic VDP can't be expanded.
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6.  Dynamic Barcodes Advanced

6.1.  Choosing a Font Standard
You can choose between two font standards for the human-readable characters of your
barcodes.

1. Go to Illustrator > Preferences > Esko >  Dynamic Barcodes Preferences... to open the
Dynamic Barcodes Preferences dialog.
 

 
2. Choose either OCR-B Standard or OCR-B Bitstream and click OK.

OCR-B Standard fonts are rounder and
typically used in the Western market.

 

 

OCR-B Bitstream fonts are typically used
in the Asian market.

 

 

Note:  If the OCR-B Bitstream font is not installed on your system, the option will be
disabled. Esko does not provide this font.

6.2.  Using Dynamic Content with Dynamic Barcodes

You can use the Dynamic Content plug-in to turn barcodes created with Dynamic Barcodes
into XML-driven objects. These barcodes update automatically when the XML files to which
they are linked change.
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For more information, see the Dynamic Content documentation.

6.3.  Barcode Protection

Once you create a barcode with Dynamic Barcodes, this barcode is protected. This means
that it won't be possible to edit it with most regular Illustrator tools. This protects the barcode
against modifications that might render it invalid, for example distorting it or modifying its size.

The only transformation allowed is moving or rotating the barcode. When rotating the barcode,
a message is shown in the Messages palette, and the barcode's Rotation parameter is adapted
accordingly.

You can still edit the barcode's parameters at any time through the Dynamic Barcodes dialog.

6.3.1.  Protecting a Barcode

You can protect a Dynamic Barcodes barcode that has been unprotected, or a barcode made in
a previous version of Dynamic Barcodes.

1. Open the Dynamic Barcodes plug-in.
2. Select the barcode to protect in your Illustrator document.
3. If necessary, change its parameters in the Dynamic Barcodes dialog.
4. Click the Apply button to apply the parameter changes and protect your barcode.

Tip:  You can use this to fix some invalid barcodes.

6.3.2.  Handling a Barcode without Dynamic Barcodes

Opening a Document Containing a Dynamic Barcodes Barcode without
Dynamic Barcodes
When opening a document containing a Dynamic Barcodes barcode in an Illustrator
application that doesn't have the Dynamic Barcodes plug-in, you will get the following warning:
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This doesn't create any problem in your file, and you can continue to work with this file as
you normally would, without editing the Dynamic Barcodes barcode.

If you need to edit the Dynamic Barcodes barcode with your Illustrator application, see Editing
a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes on page 41.

Editing a Document Containing a Dynamic Barcodes Barcode without
Dynamic Barcodes
If you don't have the Dynamic Barcodes plug-in, you can still use Illustrator to do the following
operations without rendering your barcode invalid.

If you don't have Dynamic Barcodes installed, you will not be able to

• move or scale the object using the Selection tool
• move or distort it (reflect, shear or scale)
• change a color

You will be able to

• expand the bar code
• Rotate by Selection or Free transform - this can lead to inconsistent results so we

recommend not doing this.
• move, rotate and distort by the Transform Each command - this can lead to inconsistent

results so we recommend not doing this.
• enclose it in the Envelope and distort
• delete it
• copy and paste it

If the Dynamic Barcode plugin is installed, but without a valid license, you will be able to do
everything that is allowed by the plugin, except modifying the content. This means for example
moving and rotating is allowed, but due to the bar code protection, any potentially dangerous
operations such as scale, reflect or shear are not allowed. You will also be able to change the
color of the bar code.

Unprotecting a Dynamic Barcodes Barcode for Further Editing
You can expand your Dynamic Barcodes barcode to a regular Illustrator group art to be able to
edit it further, but this is not recommended as it will remove the barcode's protection.

Attention:  It will then be possible to make modifications that might render the
barcode invalid.

1. To do this, go to Object > Expand... in the Illustrator menu.
2. Choose the object's characteristics to expand, then click OK.
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This turns your barcode into a regular Illustrator object. You can now for example edit each bar
of the barcode individually.

6.4.  Exporting Documents with Barcodes

If you are using other Esko applications, you can export Illustrator documents containing
barcodes to the Esko Normalized PDF format, preserving the barcodes' information and
editability.

6.4.1.  Viewing Barcode Information in Other Esko Applications

1. Export your Illustrator document to the Esko Normalized PDF format:

• If you have Automation Engine, use Shuttle to launch the document into your chosen
workflow. This converts it to Normalized PDF automatically.

Note:  See the Adobe Illustrator Client documentation for setup information.

• If you don't have Automation Engine, use File > Export and choose Normalized PDF as
the export format.

2. Select (in Automation Engine) or open (in PackEdge / Acrobat) your document and open the
XMP information as explained below:

If you have... go to...

Automation Engine File > Info.

PackEdge File > XMP Info.

the Esko XMP plug-in in Adobe Acrobat Esko > XMP Document Info...
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3. Click Barcodes in the Data type column (as below in PackEdge) to show the barcode
information.
 

 

For more information, see the Shuttle, Automation Engine, PackEdge or XMP plug-in
documentation.

6.4.2.  Editing Barcodes in Other Esko Applications

The Dynamic Barcodes functionality is available both as a DeskPack plug-in and in PackEdge.

• To edit your document containing barcodes in PackEdge:
a) Export your Illustrator document to the Esko Normalized PDF format:

• If you have Automation Engine, use Shuttle to launch the document into your chosen
workflow. This converts it to Normalized PDF automatically.

Note:  See the Adobe Illustrator Client documentation for setup information.

• If you don't have Automation Engine, use File > Export and choose Normalized PDF
as the export format.

b) Open your document in PackEdge.
c) Go to Production > Bar Code... to edit your barcode as you would edit it with Dynamic

Barcodes.

For more information, see the Shuttle and PackEdge documentation.
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7.  Barcode Recognition
Barcode Recognition is a new function in Dynamic Barcodes to convert vectorized
(contourized) barcodes and images (e.g. a scanned in barcode) back into live editable barcodes.

1. Choose Window > Esko > Dynamic Barcodes to open the Dynamic Barcodes palette.
 

 
2. Select the objects (lineart or image) that you want to convert.
3. Click the Extract button.

Dynamic Barcode will analyse the selected objects, and when possible a Dynamic Barcode is
generated replacing the selection.

a) Click and hold Hold to View Original to hide the converted barcode and see the original
lineart or image.

b) Change any of the barcode parameters and click Apply to modify the generated
barcode.

c) Enable Compare View to show the newly generated barcode semi transparent on top of
the original objects. This allows you to easily change position and parameters of the new
barcode to match the original.

4. When you're happy with the result, click the Finish button.

This will remove the original objects from the document and close the Barcode Recognition
session, leaving you with a barcode object that you can edit as needed.

Note:  You can not do any other barcode recognition as long as the previous session wasn't
ended, either by clicking the Finish or the Cancel button.

7.1.  Supported Barcode Types and known limitations

The barcodes that are currently supported for Barcode Recognition are these:

• EAN-13 (including add-ons)
• EAN-8
• UPC-A (including add-ons)
• UPC-E (including add-ons)
• NDC-HRI
• Int. 2 of 5
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• ITF-14
• ITF-16
• UPC-SCS
• Code-128
• Code-128 (long)
• HIBC-128
• GS1-128
• QR
• GS1-QR

The barcode parameters that are currently recognized (when possible) are these:

• Barcode type
• Code
• Add-on presence
• Color (only when recognizing line art objects)
• HRI presence (only when recognizing line art objects)
• Height (only when recognizing line art objects)
• Rotation
• Magnification
• BWR (only when recognizing line art objects)
• Characters per unit
• Ratio

Other limitations:

• White Box, Light margin indicators, H gauges for ITF barcodes and HRI text parameters are
not recognized.

• Device Compensation and Bar Width Reduction are both combined in the Bar Width
Reduction

• An Int. 2 of 5 needs to have at least 6 digits.
• UPC-SCS with add-on is not recognized.
• If the original is an image, rotation is deduced from the rotation of the image. If the barcode

inside the image is rotated over an angle other than a multiple of 90º, the recognizing will
not work.
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8.  Barcode Types and Parameters

8.1.  Supported Barcode Types

General Purpose Barcodes

1D 2D

• Code 39

• 2 of 5

• Interleaved 2 of 5

• Codabar

• Code 128

• Code 128 (long)

• MSI

• DataMatrix

• QR

• MicroQR

Retail Barcodes

1D 2D

• EAN 13

• EAN 8

• UPC-A

• UPC-E

• GS1 DataBar Omnidirectional

• GS1 DataBar Truncated

• GS1 DataBar Stacked

• GS1 DataBar Stacked Omnidirectional

• GS1 DataBar Limited

• GS1 DataBar Expanded

• GS1 DataBar Expanded Stacked

• GS1 DataMatrix
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1D 2D

• GS1 128

• GS1 U.S. Coupon Interim

• M+S 7

• Marks & Spencer

Pharmaceutical, Healthcare and Cosmetic Barcodes

1D

• NDC / HRI

• EAN 13 Swissmedic

• Laetus Pharma Code

• CLF-8

• HIBC 39

• HIBC 128

• Paraf Italy

• PZN

• PZN8

Shipment Container Barcodes

1D

• ITF-14

• ITF-16

• UPC-SCS

Identity Document Barcode

2D

• PDF417
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2D

• MicroPDF417

8.1.1.  GS1 Application Identifiers

These are the GS1 Application Identifiers available in Dynamic Barcodes:

AI Data Content Format (*) FNC1 Required

00 Serial Shipping Container Code (SSCC) N2+N18

01 Global Trade Item Number (GTIN) N2+N14

02 GTIN of Contained Trade Items N2+N14

10 Batch or Lot Number N2+X..20 (FNC1)

11 (**) Production Date (YYMMDD) N2+N6

12 (**) Due Date (YYMMDD) N2+N6

13 (**) Packaging Date (YYMMDD) N2+N6

15 (**) Best Before Date (YYMMDD) N2+N6

16 (**) Sell By Date (YYMMDD) N2+N6

17 (**) Expiration Date (YYMMDD) N2+N6

20 Internal product variant N2+N2

21 Serial Number N2+X..20 (FNC1)

22 Consumer product variant N2+X..20 (FNC1)

235 Third Party Controlled, Serialised
Extension of GTIN (TPX)

N3+X..28 (FNC1)

240 Additional Item Identification N3+X..30 (FNC1)

241 Customer Part Number N3+X..30 (FNC1)

242 Made-to-Order Variation Number N3+N..6 (FNC1)

243 Packaging Component Number N3+X..20 (FNC1)

250 Secondary Serial Number N3+X..30 (FNC1)

251 Reference to Source Entity N3+X..30 (FNC1)

253 Global Document Type Identifier (GDTI) N3+N13+X..17 (FNC1)

254 GLN Extension Component N3+X..20 (FNC1)

255 Global Coupon Number (GCN) N3+N13+N..12 (FNC1)

30 Variable Count of Items (Variable Measure
Trade Item)

N2+N..8 (FNC1)

310n (***) Net weight, kilograms (Variable Measure
Trade Item)

N4+N6
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311n (***) Length or first dimension, metres (Variable
Measure Trade Item)

N4+N6

312n (***) Width, diameter, or second dimension,
metres (Variable Measure Trade Item)

N4+N6

313n (***) Depth, thickness, height, or third
dimension, metres (Variable Measure
Trade Item)

N4+N6

314n (***) Area, square metres (Variable Measure
Trade Item)

N4+N6

315n (***) Net volume, litres (Variable Measure Trade
Item)

N4+N6

316n (***) Net volume, cubic metres (Variable
Measure Trade Item)

N4+N6

320n (***) Net weight, pounds (Variable Measure
Trade Item)

N4+N6

321n (***) Length or first dimension, inches (Variable
Measure Trade Item)

N4+N6

322n (***) Length or first dimension, feet (Variable
Measure Trade Item)

N4+N6

323n (***) Length or first dimension, yards (Variable
Measure Trade Item)

N4+N6

324n (***) Width, diameter, or second dimension,
inches (Variable Measure Trade Item)

N4+N6

325n (***) Width, diameter, or second dimension,
feet (Variable Measure Trade Item)

N4+N6

326n (***) Width, diameter, or second dimension,
yards (Variable Measure Trade Item)

N4+N6

327n (***) Depth, thickness, height, or third
dimension, inches (Variable Measure Trade
Item)

N4+N6

328n (***) Depth, thickness, height, or third
dimension, feet (Variable Measure Trade
Item)

N4+N6

329n (***) Depth, thickness, height, or third
dimension, yards (Variable Measure Trade
Item)

N4+N6

330n (***) Logistic weight, kilograms N4+N6

331n (***) Length or first dimension, metres N4+N6

332n (***) Width, diameter, or second dimension,
metres

N4+N6

49



8 Dynamic Barcodes for Adobe Illustrator

333n (***) Depth, thickness, height, or third
dimension, metres

N4+N6

334n (***) Area, square metres N4+N6

335n (***) Logistic volume, litres N4+N6

336n (***) Logistic volume, cubic metres N4+N6

337n (***) Kilograms per square metre N4+N6

340n (***) Logistic weight, pounds N4+N6

341n (***) Length or first dimension, inches N4+N6

342n (***) Length or first dimension, feet N4+N6

343n (***) Length or first dimension, yards N4+N6

344n (***) Width, diameter, or second dimension,
inches

N4+N6

345n (***) Width, diameter, or second dimension,
feet

N4+N6

346n (***) Width, diameter, or second dimension,
yard

N4+N6

347n (***) Depth, thickness, height, or third
dimension, inches

N4+N6

348n (***) Depth, thickness, height, or third
dimension, feet

N4+N6

349n (***) Depth, thickness, height, or third
dimension, yards

N4+N6

350n (***) Area, square inches (Variable Measure
Trade Item)

N4+N6

351n (***) Area, square feet (Variable Measure Trade
Item)

N4+N6

352n (***) Area, square yards (Variable Measure
Trade Item)

N4+N6

353n (***) Area, square inches N4+N6

354n (***) Area, square feet N4+N6

355n (***) Area, square yards N4+N6

356n (***) Net weight, troy ounces (Variable Measure
Trade Item)

N4+N6

357n (***) Net weight (or volume), ounces (Variable
Measure Trade Item)

N4+N6

360n (***) Net volume, quarts (Variable Measure
Trade Item)

N4+N6

361n (***) Net volume, gallons U.S. (Variable Measure
Trade Item)

N4+N6
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362n (***) Logistic volume, quarts N4+N6

363n (***) Logistic volume, gallons U.S. N4+N6

364n (***) Net volume, cubic inches (Variable
Measure Trade Item)

N4+N6

365n (***) Net volume, cubic feet (Variable Measure
Trade Item)

N4+N6

366n (***) Net volume, cubic yards (Variable Measure
Trade Item)

N4+N6

367n (***) Logistic volume, cubic inches N4+N6

368n (***) Logistic volume, cubic feet N4+N6

369n (***) Logistic volume, cubic yards N4+N6

37 Count of Trade Items N2+N..8 (FNC1)

390n (***) Applicable Amount Payable or Coupon
Value, local currency

N4+N..15 (FNC1)

391n (***) Applicable Amount Payable with ISO
Currency Code

N4+N3+N..15 (FNC1)

392n (***) Applicable Amount Payable, single
monetary area (Variable Measure Trade
Item)

N4+N..15 (FNC1)

393n (***) Applicable Amount Payable with ISO
Currency Code (Variable Measure Trade
Item)

N4+N3+N..15 (FNC1)

394n (***) Percentage discount of a coupon N4+N4 (FNC1)

400 Customer's Purchase Order Number N3+X..30 (FNC1)

401 Global Identification Number for
Consignment (GINC)

N3+X..30 (FNC1)

402 Global Shipment Identification Number
(GSIN)

N3+N17 (FNC1)

403 Routing Code N3+X..30 (FNC1)

410 Ship to - Deliver to Global Location
Number

N3+N13

411 Bill to - Invoice to Global Location Number N3+N13

412 Purchased from Global Location Number N3+N13

413 Ship for - Deliver for - Forward to Global
Location Number

N3+N13

414 Identification of a Physical Location -
Global Location Number

N3+N13

415 Global Location Number of the Invoicing
Party

N3+N13
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416 GLN of the production or service location N3+N13

417 Party GLN N3+N13

420 Ship to - Deliver to Postal Code Within a
Single Postal Authority

N3+X..20 (FNC1)

421 Ship to - Deliver to Postal Code with ISO
Country Code

N3+N3+X..9 (FNC1)

422 Country of Origin of a Trade Item N3+N3 (FNC1)

423 Country of Initial Processing N3+N3+N..12 (FNC1)

424 Country of Processing N3+N3 (FNC1)

425 Country of Disassembly N3+N3+N..12 (FNC1)

426 Country Covering full Process Chain N3+N3 (FNC1)

427 Country Subdivision of Origin N3+X..3 (FNC1)

7001 NATO Stock Number (NSN) N4+N13 (FNC1)

7002 UN/ECE Meat Carcasses and Cuts
Classification

N4+X..30 (FNC1)

7003 Expiration Date and Time N4+N10 (FNC1)

7004 Active Potency N4+N..4 (FNC1)

7005 Catch Area N4+X..12 (FNC1)

7006 First Freeze Date N4+N6

7007 Harvest Date N4+N6..12 (FNC1)

7008 Species for Fishery Purposes N4+X..3 (FNC1)

7009 Fishing Gear Type N4+N..10 (FNC1)

7010 Production Method N4+X..2 (FNC1)

7020 Refurbishment lot ID N4+X..20 (FNC1)

7021 Functional status N4+X..20 (FNC1)

7022 Revision status N4+X..20 (FNC1)

7023 Global Individual Asset Identifier (GIAI) of
an assembly

N4+X..30 (FNC1)

703s Number of Processor with ISO Country
Code

N4+N3+X..27 (FNC1)

7040 GS1 UIC with Extension 1 and Importer
index

N4+N1X2+X3+X4 (FNC1)

710 National Healthcare Reimbursement
Number (NHRN) – Germany PZN

N3+X..20 (FNC1)

711 National Healthcare Reimbursement
Number (NHRN) – France CIP

N3+X..20 (FNC1)
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712 National Healthcare Reimbursement
Number (NHRN) – Spain CN

N3+X..20 (FNC1)

713 National Healthcare Reimbursement
Number (NHRN) – Brasil DRN

N3+X..20 (FNC1)

714 National Healthcare Reimbursement
Number (NHRN) - Portugal AIM

N3+X..20 (FNC1)

723s (****) Certification reference N4+X2+X...28 (FNC1)

7240 Clinical Trial Protocol ID N4+X..20 (FNC1)

8001 Roll Products (Width, Length, Core
Diameter, Direction, Splices)

N4+N14 (FNC1)

8002 Cellular Mobile Telephone Identifier N4+X..20 (FNC1)

8003 Global Returnable Asset Identifier (GRAI) N4+N14+X..16 (FNC1)

8004 Global Individual Asset Identifier (GIAI) N4+X..30 (FNC1)

8005 Price Per Unit of Measure N4+N6 (FNC1)

8006 Identification of the Components of a
Trade Item

N4+N14+N2+N2 (FNC1)

8007 International Bank Account Number (IBAN) N4+X..34 (FNC1)

8008 Date and Time of Production N4+N8+N..4 (FNC1)

8010 Component / Part Identifier (CPID) N4 + X..30 (FNC1)

8011 Component / Part Identifier Serial Number
(CPID SERIAL)

N4 + N..12 (FNC1)

8012 Software version N4+X..20 (FNC1)

8013 Global Model Number (GMN) N4+X..30 (FNC1)

8017 Global Service Relation Number to identify
the relationship between an organisation
offering services and the provider of
services

N4+N18 (FNC1)

8018 Global Service Relation Number to identify
the relationship between an organisation
offering services and the recipient of
services

N4+N18 (FNC1)

8019 Service Relation Instance Number (SRIN) N4+N..10 (FNC1)

8020 Payment Slip Reference Number N4+X..25 (FNC1)

8026 ITIP of contained pieces N4+N18

8110 Coupon Code Identification for Use in
North America

N4+X..70 (FNC1)

8111 Loyalty points of a coupon N4+N4 (FNC1)

8112 Paperless coupon code identification for
use in North America

N4+X..70 (FNC1)
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8200 Extended Packaging URL N4+X..70 (FNC1)

90 Information Mutually Agreed Between
Trading Partners

N2+X..30 (FNC1)

91 to 99 Company Internal Information N2+X..30 (FNC1)

Notes
• *: The first position indicates the length (number of digits) of the GS1 Application Identifier.

The following value refers to the format of the data content.

The following convention is applied:

N numeric digit

X any character

N3 3 numeric digits, fixed length

N..3 up to 3 numeric digits

X..3 up to 3 characters

• **: If only year and month are available, DD must be filled with two zeroes.

• ***: The fourth digit of this GS1 Application Identifier indicates the implied decimal point
position. Example:

• 3100 Net weight in kg without a decimal point
• 3102 Net weight in kg with two decimal points

• FNC1: All GS1 Application Identifiers indicated with (FNC1) are defined as of variable length
and shall be delimited unless this Element String is the last one to be encoded in the
symbol. The delimiter shall be a Function 1 Symbol Character in GS1-128 Symbology, GS1
DataBar Expanded Versions and GS1 Composite Symbology and should be a Function 1
Symbol Character in GS1 DataMatrix and GS1 QR Code Symbology.

• ****: The fourth digit of this AI indicates the sequence number, allowing multiple
occurrences of this AI

8.2.  Barcode Types
To create a barcode of a specific type, select it in the Barcode Type parameter. This displays
parameters specific to this barcode type in the Dynamic Barcodes dialog.

8.2.1.  2 of 5

About this Barcode...
2 of 5 is a numeric self-checking barcode, which can have a variable length. This barcode
only encodes data in the bars. It is used for industrial applications, article numbering, photo
development and ticketing.
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Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Characters per unit on page 101

• Ratio on page 103

• Narrow Bar on page 103

• Box on page 108

8.2.2.  CLF-8

About this Barcode...
The CLF-8 barcode is part of the same barcode family as the Laetus Pharma Code. It is used in
the pharmaceutical industry.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95
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Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Ratio on page 103

• Narrow Bar on page 103

• Wide Bar on page 104

• Gap on page 104

• Decimal Input on page 105

8.2.3.  Codabar

About this Barcode...
The Codabar barcode is commonly used in libraries, blood banks, and the air parcel business.
It can encode up to 126 characters of data and two control characters, using digits and the “-”,
“$”, “:”, “/” and “+” characters.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98
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Additional Parameters

• Rational (Constant Bar Width): By enabling this option, you can create a "Rational"
Codabar bar code.

• Use “992” Prod. Family in UPC on page 99

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Characters per unit on page 101

• Ratio on page 103

• Narrow Bar on page 103

• Box on page 108

8.2.4.  Code 128

About this Barcode...
Code 128 is a variable length, high density, alphanumeric barcode. It has the second highest
density of all the 1D barcodes (after the GS1 Databar Expanded).

It can contain a set of control characters. These control characters can change the character
encoding type. In the absence of control characters, the encoding type is chosen automatically,
to optimize the content encoding.

To force the usage of the code-set A, precede your data with the [a] control character. To force
the usage of the code-set B, precede your data with the [b] control character. To obtain an
optimal utilization of the code-sets A and B but prevent the usage of the space saving code-set
C, use the Code 128 (long) barcode type instead.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Light Margin Indicator on page 97

• Font Family, Style and Size on page 98
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• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Characters per unit on page 101

• Narrow Bar on page 103

• Width on page 103

• Box on page 108

8.2.5.  Code 128 (long)

About this Barcode...
Code 128 (long) is a version of Code 128 that doesn't use the space-saving “C” character set.
This makes Code 128 (long) barcodes generally longer.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Light Margin Indicator on page 97

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101
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• Characters per unit on page 101

• Narrow Bar on page 103

• Width on page 103

• Box on page 108

8.2.6.  Code 39

About this Barcode...
Code 39 is a popular barcode in industrial barcoding systems, mainly in the U.S.A. It is used in
the non-retail industry, particularly in the manufacturing, military, and health sectors. It can
encode alphanumeric data.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Characters per unit on page 101

• Ratio on page 103

• Narrow Bar on page 103

• Add Check Digit on page 105

• Box on page 108
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8.2.7.  DataMatrix

About this Barcode...
DataMatrix is used for encoding large amounts of alphanumeric data and / or marking small
objects. It can encode all the standard ASCII and extended ASCII characters.

The DataMatrix symbol size can adjust automatically depending on the amount of data.

Dynamic Barcodes doesn't generate human readable characters for DataMatrix symbols. The
data to be encoded in a DataMatrix symbol can contain an FNC1 character but only at the
beginning of the data.

Note:  Dynamic Barcodes always generates DataMatrix symbols with the recommended
ECC200 error correction scheme.

 

 

DataMatrix Macro functions
Using DataMatrix Macro sequences, you can reduce the amount of data to encode by omiting
obvious headers and trailers. The structured data uses control characters, entered using their
standard abbreviations between "<" and ">"

The Macro sequence contains different parts:

• The optional Macro header: [)>. This is optional, and can be omited

• One of the starting sequences: <RS>05<GS> or <RS>06<GS>

• The macro content in a structured format
• The ending sequence: <RS><EOT>

Here are a few examples of a valid Macro function:

• [)><RS>05<GS>PAP16559-2<GS>S0<72>017<GS>IPWP4511<RS><EOT>

• <RS>05<GS>PAP16559-2<GS>S0<72>017<GS>IPWP4511<RS><EOT>

Note that apart from the Macro functions, you can enter all control characters to a DataMatrix
code. These are all accepted codes:

<NUL><SOH><STX><ETX><EOT><ENQ><ACK><BEL><BS><HT><LF><VT><FF><CR><SO><SI><DLE><DC1><DC2><DC3><DC4><NAK><SYN><ETB><CAN><EM><SUB><ESC><FS><GS><RS><US>

Note:  If you want to use one of the control character substitutions literally (e.g. "<EOT>") it can
be escaped by doubling the first character: <<EOT>

Parameters
General Parameters

• Rotation on page 95

• Code on page 95
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Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Symbol Type on page 105

• Cell Size on page 106

• Width / Total Height on page 106

• Box on page 108

8.2.8.  EAN 8

About this Barcode...
EAN 8 is an abbreviated version of EAN 13, for use on smaller packages. It can encode eight
digits, and can have two or five additional digits.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Light Margin Indicator on page 97

• Add-on Text On Top on page 98

• Font Family, Style and Size on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Magnification on page 100

• Height on page 101
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• Snap Bars to Output Resolution on page 104

• Box on page 108

8.2.9.  EAN 13

About this Barcode...
European Article Numbering system or EAN is the standard for article numbering in Europe. It
is also used in Japan where it is called JAN.

Note:  EAN is the European equivalent of the UPC system in the U.S.A. and Canada. Both
systems use the same size requirements and a similar encoding scheme. This means that most
European and American retail barcode scanners can read both EAN and UPC barcodes. For
more information on UPC, see UPC-A on page 92.

 

 

An EAN 13 is a numeric barcode of thirteen digits, and can have two or five additional digits.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Light Margin Indicator on page 97

• Add-on Text On Top on page 98

• Font Family, Style and Size on page 98

• Vertical Offset on page 98
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Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Magnification on page 100

• Height on page 101

• Snap Bars to Output Resolution on page 104

• Box on page 108

8.2.10.  EAN 13 Swissmedic

About this Barcode...
EAN 13 Swissmedic is an EAN 13 barcode used for items licensed by the Swiss Agency for
Theraputic Products

It always starts with "7680", uses a specific text positioning and adds the text "swissmedic"
below the code.

For EAN 13 Swissmedic barcodes, only the default font settings can be used.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Magnification on page 100

• Height on page 101

• Snap Bars to Output Resolution on page 104
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• Box on page 108

8.2.11.  GS1 128

About this Barcode...
GS1 128 (formerly EAN 128) is a Code 128 barcode designed primarily to identify products.

It contains one or more FNC1 (GS1 Function Code 1) control characters and Application
Identifiers. It shows parentheses around the human readable interpretation of the Application
Identifiers, but those parentheses are not encoded in the barcode.

 

 

It is alphanumeric and can also contain composite symbols.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

• Composite Component on page 96

Text Parameters

• Add Human Readable Characters on page 96

• Put on Top on page 97

• Multiple Text Lines on page 97

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters
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• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Narrow Bar on page 103

• Snap Bars to Output Resolution on page 104

• Box on page 108

8.2.12.  GS1 DataBar Omnidirectional

About this Barcode...
Barcodes of the GS1 DataBar family (formerly Reduced Space Symbols or RSS) can identify
small items, and encode more information than the current EAN or UPC barcodes.

They can include GS1 Application Identifiers such as serial numbers, lot numbers, expiration
dates...

Note:  GS1 DataBar codes are expected to replace most common EAN and UPC barcodes from
2010.

GS1 DataBar Omnidirectional encodes Global Trade Item Numbers (GTIN) in a linear symbol
that can be scanned omnidirectionally by suitably programmed slot scanners.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

• Composite Component on page 96

Text Parameters

• Add Human Readable Characters on page 96

• Put on Top on page 97

• Multiple Text Lines on page 97

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters
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• Bar Width Reduction on page 100

• Device Compensation on page 100

• Narrow Bar on page 103

• Snap Bars to Output Resolution on page 104

8.2.13.  GS1 DataBar Stacked

About this Barcode...
GS1 DataBar Stacked is a variation of the GS1 DataBar barcode, that is stacked in two rows and
used when the normal barcode would be too wide for the product.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

• Composite Component on page 96

Text Parameters

• Add Human Readable Characters on page 96

• Multiple Text Lines on page 97

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Narrow Bar on page 103

• Snap Bars to Output Resolution on page 104

8.2.14.  GS1 DataBar Stacked Omnidirectional

About this Barcode...
GS1 DataBar14 Stacked Omnidirectional is taller version of GS1 DataBar14 Stacked, that can be
read by omnidirectional scanners.
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Parameters
General Parameters

• Rotation on page 95

• Code on page 95

• Composite Component on page 96

Text Parameters

• Add Human Readable Characters on page 96

• Put on Top on page 97

• Multiple Text Lines on page 97

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Narrow Bar on page 103

• Snap Bars to Output Resolution on page 104

8.2.15.  GS1 DataBar Truncated

About this Barcode...
GS1 DataBar Truncated (formerly RSS Limited) is similar to GS1 DataBar but the height of its
bars is truncated.

It encodes Global Trade Item Numbers in a smaller symbol for use on small items. It cannot be
scanned omnidirectionally.
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Parameters
General Parameters

• Rotation on page 95

• Code on page 95

• Composite Component on page 96

Text Parameters

• Add Human Readable Characters on page 96

• Put on Top on page 97

• Multiple Text Lines on page 97

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Narrow Bar on page 103

• Snap Bars to Output Resolution on page 104

8.2.16.  GS1 DataBar Expanded

About this Barcode...
GS1 DataBar Expanded (formerly RSS Expanded) encodes regular barcode data (“primary item
identification” data) and Application Identifiers. It can encode alphanumeric characters.

This barcode can be scanned omnidirectionally by suitably programmed slot scanners.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95
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• Composite Component on page 96

Text Parameters

• Add Human Readable Characters on page 96

• Put on Top on page 97

• Multiple Text Lines on page 97

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Narrow Bar on page 103

• Snap Bars to Output Resolution on page 104

8.2.17.  GS1 DataBar Expanded Stacked

About this Barcode...
GS1 DataBar Expanded Stacked can encode the same amount of data as GS1 DataBar
Expanded, but can also “stack” the barcode into several rows to save space.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

• Composite Component on page 96

Text Parameters
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• Add Human Readable Characters on page 96

• Put on Top on page 97

• Multiple Text Lines on page 97

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Max. Row Width on page 99

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Narrow Bar on page 103

• Snap Bars to Output Resolution on page 104

8.2.18.  GS1 DataBar Limited

About this Barcode...
GS1 Databar Limited is smaller than the GS1 DataBar barcode and can only encode Global
Trade Item Numbers whose data part starts with “1”.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

• Composite Component on page 96

Text Parameters

• Add Human Readable Characters on page 96

• Put on Top on page 97

• Multiple Text Lines on page 97

• Font Family, Style and Size on page 98

• Alignment on page 98
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• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Narrow Bar on page 103

• Snap Bars to Output Resolution on page 104

8.2.19.  GS1 DataMatrix

About this Barcode...
The GS1 Data Matrix barcode is a high density, high capacity, scalable 2D barcode. It is used to
concentrate a lot of (alphanumeric) information in a very small space.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Put on Top on page 97

• Multiple Text Lines on page 97

• Light Margin Indicator on page 97

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Symbol Type on page 105

• Cell Size on page 106
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• Width / Total Height on page 106

• Box on page 108

8.2.20.  GS1 QR

About this Barcode...
The GS1 QR barcode is a high density, high capacity, scalable 2D barcode. It is used to assembly
multiple GS1 Application Identifiers to a barcode with limited space needs. The GS1 QR
barcode can contain numbers, 0 - 9, upper case letters A -Z, and nine special characters: space
$ % * + - . /

For more technical information on the QR code, see QR on page 88

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Put on Top on page 97

• Multiple Text Lines on page 97

• Light Margin Indicator on page 97

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Symbol Type on page 105

• Cell Size on page 106

• Width / Total Height on page 106

• Box on page 108

Specific Parameters
Minimum Symbol Size

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical
cells”).
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Note:  If the number of cells you choose for your symbol is too small to encode the data you
entered in Code, Dynamic Barcodes will use a bigger symbol size automatically.

Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.

• Level M: 15% of codewords can be restored.

• Level Q: 25% of codewords can be restored.

• Level H: 30% of codewords can be restored.

Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check
sums are added to the barcode) and may limit the maximum length of the encoded data.

Width / Height

The Width and Height parameters depend on the Cell Size and the number of cells used for
the symbol (Minimum Symbol Size).

For example, a symbol of 25 x 25 cells where each cell is 2 mm gives a Width and Height of 50
x 50 mm.

8.2.21.  GS1 U.S. Coupon Interim

About this Barcode...
GS1 U.S. Coupon Interim is an interim coupon barcode. It is used during the transition between
UPC-A coupons and the new GS1 Databar Expanded Stacked coupons, that can encode more
information.

It is made of both an old UPC-A coupon barcode, and a new Databar Expanded Stacked
coupon barcode, to be readable by both old and new scanners.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters
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• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

Additional Parameters

• Use “992” Prod. Family in UPC on page 99

• Max. Row Width on page 99

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Magnification on page 100

• Narrow Bar on page 103

• Gap on page 104

• Vertical alignment on page 104

8.2.22.  HIBC 128

About this Barcode...
This barcode is based on the Code 128 symbology.

It encodes the organization's primary and / or secondary Labeler Identification Code (LIC). This
encoding begins with the “+” character. If both primary and secondary Labeler Identification
Codes are encoded in one barcode, they are divided by the “/” character.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100
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• Height on page 101

• Characters per unit on page 101

• Narrow Bar on page 103

• Width on page 103

• Box on page 108

8.2.23.  HIBC 39

About this Barcode...
This barcode is based on the Code 39 symbology.

It encodes the organization's primary and / or secondary Labeler Identification Code (LIC). This
encoding begins with the “+” character. If both primary and secondary Labeler Identification
Codes are encoded in one barcode, they are divided by the “/” character.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Characters per unit on page 101

• Ratio on page 103

• Narrow Bar on page 103
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• Box on page 108

8.2.24.  ITF-14

About this Barcode...
ITF-14 is a standardized version of the Interleaved 2 of 5 barcode, containing 14 digits, the last
being a check digit.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Vertical Offset on page 98

Additional Parameters

• Text Format on page 99

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Magnification on page 100

• Height on page 101

• Snap Bars to Output Resolution on page 104

• Total Height on page 107

• Smax / Smin on page 107

• Box on page 108

8.2.25.  ITF-16

About this Barcode...
ITF-16 is a standardized version of the Interleaved 2 of 5 barcode, containing 16 digits, the last
being a check digit.
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Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Vertical Offset on page 98

Additional Parameters

• Text Format on page 99

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Magnification on page 100

• Height on page 101

• Snap Bars to Output Resolution on page 104

• Total Height on page 107

• Smax / Smin on page 107

• Box on page 108

8.2.26.  Interleaved 2 of 5

About this Barcode...
Interleaved 2 of 5 (or Int. 2 of 5) is a barcode originally used for transportation packaging, that
can have any even number of digits. Since this type of packaging consists mainly of cardboard
boxes printed in low quality, the Interleaved 2 of 5 barcode is more tolerant to distortion than
other barcodes.
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Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Characters per unit on page 101

• Ratio on page 103

• Narrow Bar on page 103

• Box on page 108

8.2.27.  Laetus Pharma Code

About this Barcode...
This barcode was developed specifically to meet the requirements of the pharmaceutical
packaging process. It has established itself as the worldwide pharmaceutical industry barcode
standard. It can encode numeric or binary data.

 

 

Parameters
Laetus Pharma

General Parameters

• Rotation on page 95
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• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Miniature: Use this option to create a miniature version of the bar code

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Ratio on page 103

• Narrow Bar on page 103

• Wide Bar on page 104

• Gap on page 104

• Decimal Input on page 105

• Box on page 108

8.2.28.  M+S 7

About this Barcode...
The M+S 7 barcode is an EAN 8 barcode modified by Marks & Spencer's, for use on own-brand
products sold in their stores.

To make the M+S 7 barcode, the initial “0” is removed and the extra letters “M” and “S” are
added to the human readable characters.

This means that the human readable characters contain seven digits plus the “M” and “S”
letters.

Note:  This doesn't affect the data encoded in the barcode (it still encodes eight digits), so you
should enter eight digits when creating a M+S 7 barcode.
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Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Magnification on page 100

• Height on page 101

• Snap Bars to Output Resolution on page 104

• Box on page 108

8.2.29.  MSI

About this Barcode...
MSI, also known as Modified Plessey, was developed by the MSI Data Corporation, based on
the original Plessey Code. It is a numeric barcode used primarily to mark retail shelves for
inventory control.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96
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• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Characters per unit on page 101

• Ratio on page 103

• Narrow Bar on page 103

• Box on page 108

8.2.30.  Marks & Spencer's

About this Barcode...
The Marks & Spencer's barcode is also an EAN 8 barcode modified by Marks & Spencer's for
use on own-brand products.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100
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• Device Compensation on page 100

• Magnification on page 100

• Height on page 101

• Snap Bars to Output Resolution on page 104

• Box on page 108

8.2.31.  NDC / HRI

About this Barcode...
The NDC / HRI barcode is a variant of the UPC barcode with special human readable
interpretation formats compliant to the US National Drug Code definition.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Vertical Offset on page 98

Additional Parameters

• Text Format on page 99

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Magnification on page 100

• Height on page 101

• Snap Bars to Output Resolution on page 104
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• Box on page 108

8.2.32.  Paraf Italy

About this Barcode...
This barcode is a variant of Code 39 used by the Italian Health and Cosmetics Industry. It is also
called Code 32.

 

 

Use Code Base32 when your barcode data is encoded in the Base 32 format. This format uses
case-insensitive alphanumeric characters to encode data.

Use Code Base10when your barcode data is in decimal format. Paraf Italy barcodes in decimal
format should start with an “A” (included automatically by Dynamic Barcodes), have 8 digits of
data and end with a check digit (calculated automatically by Dynamic Barcodes).

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Narrow Bar on page 103

• Box on page 108

8.2.33.  PDF417

About this Barcode...
PDF417 is a 2D barcode mainly used in security printing (passports, identity cards, driving
licences...).

It is a “self-checking” barcode that can have different levels of error correction.

It can encode data using one of three “compaction” modes: Text (to encode all alphanumeric
and punctuation characters in the ISO-8859-1 character set), Numeric (to encode only numeric
characters) or Binary (to encode 8-bit characters).

It can use the three compaction modes in a single barcode if necessary, but you can choose to
disable the Text and/or Numeric compaction modes.
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Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Narrow Bar on page 103

• Box on page 108

Specific Parameters
Columns
You can give your barcode between 1 and 30 Columns. The number of columns corresponds
to the number of PDF417 codewords.

Rows
You can give your barcode between 3 and 90 Rows.

Truncated
Choose Truncated to make the symbol less wide by truncating the end character (which is not
part of the encoded data) and the end pattern. In the example below, the top PDF417 barcode
is not truncated, and the bottom barcode is truncated (but encodes the same data).
 

 

Initialize in Alpha Submode
Choose this option to generate a “shift to Text mode” character at the beginning of the
barcode when using Text compaction mode. This makes the encoding clear for barcode
scanners.

Allow Text Compaction

Choose this to let Dynamic Barcodes switch to Text compaction mode automatically when
your barcode contains text data.
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This encodes the text data in your barcode more efficiently (it makes that part of your barcode
smaller).

Allow Numeric Compaction

Choose this to let Dynamic Barcodes switch to Numeric compaction mode automatically when
your barcode contains numeric data.

This encodes the numeric data in your barcode more efficiently.

Note:

Dynamic Barcodes can always switch to the Binary compaction mode if your barcode contains
binary data.

If you don't enable either Allow Text Compaction or Allow Numeric Compaction, Dynamic
Barcodes will only use Binary compaction mode.

Error Correction Level

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose an Error correction level from 0 to 8.

The higher the correction level, the more check sums are added to the barcode and the more
incorrect data can be corrected. Keep in mind that a higher correction level makes the barcode
bigger and may limit the maximum length of the encoded data.

Note:  Level 0 means that there is only one check sum added to the data, so incorrect data
can be detected but not corrected.

You can choose Automatic to let the plug-in pick the best error correction level for the data
encoded.

8.2.34.  MicroPDF417

About this Barcode...
MicroPDF417 is a 2D multi-row barcode derived from PDF417, for use on smaller areas. It can
encode up to 150 bytes.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101
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• Narrow Bar on page 103

• Snap Bars to Output Resolution on page 104

• Box on page 108

Specific Parameters
Columns
You can give your barcode between 1 and 4 Columns.

Rows
You can give your barcode between 4 and 44 Rows.

Allow Text Compaction

Choose this to let Dynamic Barcodes switch to Text compaction mode automatically when
your barcode contains text data.

This encodes the text data in your barcode more efficiently (it makes that part of your barcode
smaller).

Allow Numeric Compaction

Choose this to let Dynamic Barcodes switch to Numeric compaction mode automatically when
your barcode contains numeric data.

This encodes the numeric data in your barcode more efficiently.

Note:

Dynamic Barcodes can always switch to the Binary compaction mode if your barcode contains
binary data.

If you don't enable either Allow Text Compaction or Allow Numeric Compaction, Dynamic
Barcodes will only use Binary compaction mode.

8.2.35.  PZN

About this Barcode...
The PZN (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and
healthcare products in Germany. The PZN code is written in the format “PZN-nnnnnnn” but
only the numeric part including the leading dash is encoded.

 

 

Parameters
General Parameters
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• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Size on page 101

• Height on page 101

• Characters per unit on page 101

• Ratio on page 103

• Narrow Bar on page 103

• Box on page 108

8.2.36.  PZN8

About this Barcode...
The PZN8 (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and
healthcare products in Germany. The PZN code is written in the format “PZN-nnnnnnnn” but
only the numeric part including the leading dash is encoded.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96
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• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Size on page 101

• Height on page 101

• Characters per unit on page 101

• Ratio on page 103

• Narrow Bar on page 103

• Box on page 108

8.2.37.  QR

About this Barcode...
The QR barcode is a 2-dimensional barcode used for commercial tracking and convenience-
oriented applications aimed at mobile phone users (known as "mobile tagging").

QR codes storing addresses and URLs may appear in magazines, on signs, buses, business
cards, or other objects... Users with a camera phone equipped with the correct reader
application can scan the QR code to display text, contact information, connect to a wireless
network, or open a web page in the phone's browser.

 

 

QR codes have the following structure:

 

 

•

 Position pattern (required)
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•

 Alignment pattern (required)

•

 Timing pattern (required)

•
 Version information

•
 Format information

•
 Data and error correction keys

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Cell Size on page 106

• Width / Total Height on page 106

• Box on page 108

Specific Parameters
Minimum Symbol Size

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical
cells”).

Note:  If the number of cells you choose for your symbol is too small to encode the data you
entered in Code, Dynamic Barcodes will use a bigger symbol size automatically.

Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.

• Level M: 15% of codewords can be restored.

• Level Q: 25% of codewords can be restored.

• Level H: 30% of codewords can be restored.

Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check
sums are added to the barcode) and may limit the maximum length of the encoded data.
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Width / Height

The Width and Height parameters depend on the Cell Size and the number of cells used for
the symbol (Minimum Symbol Size).

For example, a symbol of 25 x 25 cells where each cell is 2 mm gives a Width and Height of 50
x 50 mm.

8.2.38.  MicroQR

About this Barcode...
The Micro QR Code is a very small QR Code for use on smaller spaces (for example to encode
the ID of printed circuit boards and electronics parts).

It works with smaller amounts of data (maximum 35 numeric characters), and uses only one
position pattern.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Cell Size on page 106

• Width / Total Height on page 106

• Box on page 108

Specific Parameters
Minimum Symbol Size

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical
cells”).

Note:  If the number of cells you choose for your symbol is too small to encode the data you
entered in Code, Dynamic Barcodes will use a bigger symbol size automatically.

Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.

90



8Dynamic Barcodes for Adobe Illustrator

• Level M: 15% of codewords can be restored.

• Level Q: 25% of codewords can be restored.

• Level H: 30% of codewords can be restored.

Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check
sums are added to the barcode) and may limit the maximum length of the encoded data.

Width / Height

The Width and Height parameters depend on the Cell Size and the number of cells used for
the symbol (Minimum Symbol Size).

For example, a symbol of 15 x 15 cells where each cell is 2 mm gives a Width and Height of 30
x 30 mm.

8.2.39.  SICK Code

About this Barcode...
SICK is a bar code used in the German packaging industry. It's a binary bar code, using a thick
bar for a 0, and a thin bar for a 1. It can have up to 12 bars. It can encode numeric or binary
data.

• In binary mode all digits are encoded including leading zeroes, ie. "0001" is encoded as a
three thin and one thick bar.

• In decimal mode you can define the number of bars in total, by enter e.g. "6/4". The
first number (6) defines  the total number of bars, the second (4) defines the valueto
be encoded. If you don't define the number of bars, in other words if you enter a single
number, the minimal number of bars needed for the value is used, and the code is adjusted
accordingly. If you for example enter "9", the value will change to "4/9", as you need at least
4 bars to encode this value.

• The defaults follow the mostly used standard "Codetype A", for generating the "Codetype
B" should be changed the barcode parameters as following: Narrow Bar to 1.25mm (from
0.5mm), Wide Bar to 3.75mm (from 1.5mm) and Gap to 2.5mm (from 1mm)

By default, the values for the Narrow Bar (0.5mm), Wide Bar (1.5mm) and Gap (1mm) are
set for the mostly used standard "Codetype A". If you want to generate a SICK code using
"Codetype B", you should set the Narrow Bar to 1.25mm, the Wide Bar to 3.75mm and the Gap
to 2.5mm

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters
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• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Alignment on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Height on page 101

• Ratio on page 103

• Narrow Bar on page 103

• Wide Bar on page 104

• Gap on page 104

• Decimal Input on page 105

• Box on page 108

8.2.40.  UPC-A

About this Barcode...
Universal Product Code or UPC is the standard for article numbering in the U.S.A. and Canada.
It is similar to the EAN system and compatible with it. For more information on EAN, see EAN 13
on page 62.

 

 

UPC-A is a numeric barcode of up to twelve digits, plus two or five additional digits.
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Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Magnification on page 100

• Height on page 101

• Snap Bars to Output Resolution on page 104

• Box on page 108

8.2.41.  UPC-E

About this Barcode...
UPC-E is an abbreviated version of UPC-A, for use on smaller packages. It is a numeric barcode
of eight digits, with an optional 2 or 5 digits add-on. You can also directly enter the 12-digit
code of UPC-A codes that can be represented in 8 digits.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95
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Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Vertical Offset on page 98

Additional Parameters

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Magnification on page 100

• Height on page 101

• Snap Bars to Output Resolution on page 104

• Box on page 108

8.2.42.  UPC-SCS

About this Barcode...
The UPC–SCS (Shipping Container Symbol) barcode is a version of the Interleaved 2 of 5
barcode that has a structure very similar to the Universal Product Code's (UPC) and specific
formatting of the human readable interpretation.

 

 

Parameters
General Parameters

• Rotation on page 95

• Code on page 95

Text Parameters

• Add Human Readable Characters on page 96

• Font Family, Style and Size on page 98

• Vertical Offset on page 98
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Additional Parameters

• Text Format on page 99

• Bar Width Reduction on page 100

• Device Compensation on page 100

• Magnification on page 100

• Height on page 101

• Snap Bars to Output Resolution on page 104

• Total Height on page 107

• Box on page 108

8.3.  Barcode Parameters

8.3.1.  Rotation

To rotate your barcode by 90, 180 or 270 degrees, use the Rotation buttons.

 

 

To rotate it by any other angle, enter that angle in the Rotation field.

8.3.2.  Code

Enter the data to encode in your bar code.

Dynamic Barcodes checks that the data you have entered is valid for your chosen Barcode
Type. If it isn't, a warning / error will pop up.

Code for GS1 Bar Codes
When entering data to be encoded in GS1 bar codes, you can either enter Application
Identifiers (AI) including the brackets, or you can enter the code without brackets, using FNC1
code at the end of each variable-length element in the data. While entering GS1 data, following
remarks should be taken into account:

• Do not add the mandatory FNC1 character at the beginning of the data. Dynamic Barcodes
will add it automatically.

• For GS1 bar codes intended for encoding AI (01) only, AI has to be omitted, i.e. don't enter
'01' at the beginning. It doesn't matter if entered with or without brackets.
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• The Composite Component can be created using the same rules for using brackets and [F1].
It's not necessary to keep the same way of entering the Composite Component and the
main code.

• If you don't use brackets for entering AI, type [F1] at the end of each variable-length
element in the data, to represent a FNC1 terminating character, except when the variable-
length element is placed at the end of the whole code.

• You don't need to type [F1] at the end of fixed-length elements.

• Do not mix using [F1] as terminators of variable AI and entering brackets around the AI.

 

 

Dynamic Barcodes also checks the validity of the Application Identifiers you enter in the Code
and / or in the Composite Component of GS1 bar codes.

8.3.3.  Composite Component

A Composite Component is a 2D symbol placed on top of a GS1 barcode, that encodes extra
information (batch number, expiration date...).

If you want your barcode to have a Composite Component, enter the (alphanumeric) data to
encode in this field.

Note:  Dynamic Barcodes checks the data you enter for the Composite Component (for
example to see if the Application Identifiers you entered are correct), and displays a warning if
it is invalid.
 

 

8.3.4.  Add Human Readable Characters

This parameter adds “human readable” characters (numeric or alphanumeric characters)
under your barcode.

This is the same barcode with and without human readable characters:
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8.3.5.  Put on Top

This parameter allows you to put the Human Readable Characters above instead of below the
barcode bars.

8.3.6.  Multiple Text Lines

Select this parameter if you want the human readable characters to be printed on multiple
lines below the barcode. Dynamic Barcodes will start a new line for every element of the
barcode data (starting with the Application Identifier).

 

 

Note:  When opening your document in PackEdge, the characters will be placed back on a
single line.

8.3.7.  Light Margin Indicator

This parameter adds “<“ and “>” signs (or only “>” depending on the barcode type) at the
bottom of your barcode. This indicates the width the barcode should have for optimal reading.
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Note:  When creating a bar code, the current Light Margin Indicator setting is stored for the
specific barcode type. This means that the next time you select the same barcode type (e.g.
when creating a new barcode of that same type) the Light Margin Indicator setting will be
adjusted.

8.3.8.  Add-on Text On Top

This parameter allows you to put the add-on HRI text above instead of below the barcode bars.
By default, this option is enabled.

8.3.9.  Font Family, Style and Size

These options can be used to define the font family, style and size to be used for the human
readable characters. By choosing [default font], all other Text Parameters are disabled, as the
default values are used.

Note:  If the font used in a bar code is not available when opening the file, Adobe Illustrator
will warn about a missing font. You can however only fix the problem using the Dynamic
Barcode palette, since Adobe Illustrator's "Find Font" feature can not be used.

8.3.10.  Alignment

When using human readable characters, in combination with custom font settings, you can set
text alignment to Left, Center or Right.

8.3.11.  Vertical Offset

This parameter allows you to add extra space between your barcode bars and the human
readable characters.
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Note:  When opening your document in PackEdge, the characters will be placed just below the
bars again.

8.3.12.  Use “992” Prod. Family in UPC

Enable this parameter to use the special “992” product family in your barcode (for specific
offers like discounts on the customer's next purchase or on variable weight items...).

8.3.13.  Max. Row Width

Use this parameter to define how many segments of data (groups of bars encoding several
digits) can fit in one row. If the barcode contains more segments, they will be stacked.

In the example below, the first barcode has a Max. Row Width of 8 segments. When reducing
this to 4 segments, the segments that don't fit in the row width anymore are stacked, forming a
second row (second barcode).

 

 

The GS1 Max Row Width parameter applies to the GS1 Databar Expanded Stacked component
of the GS1 U.S. Coupon Interim barcode.

8.3.14.  Text Format

Choose a text format for the human readable characters of your barcode.

For NDC/HRI barcodes, you can choose a variant of the U.S. National Drug Code.
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For ITF-14, ITF-16 and UPC-SCS barcodes, you can choose a variant of the Shipping Container
Symbol.

8.3.15.  Bar Width Reduction

Use this to adjust the width of barcode bars, in order to compensate for ink bleeding when
printing on your substrate.

Your printer or customer will usually provide you with the value to use. For example if your
printer tells you that the line width will increase by 0.01mm, you should use a Bar Width
Reduction value of 0.01 mm.

You can enter the Bar Width Reduction in microns, milliinches (“mil”), millimeters or inches.

Tip:  You can enter a negative value if you want to print thicker and not thinner bars.

8.3.16.  Device Compensation

Use this if your printer gave you a separate device bleed value. This parameter adjusts the
bar's width to compensate for bleed caused by the plate or film making process.

You can enter the Device Compensation in microns, milliinches (“mil”), millimeters or inches.

Note:  If you use both a Bar Width Reduction and a Device Compensation value, Dynamic
Barcodes will add them to adjust the bar's width.

Tip:  You can enter a negative value if you want to print thicker and not thinner bars.

8.3.17.  Magnification

Use this parameter to increase or decrease the barcode size proportionally.

In the example below, you can see the same barcode at 80%, 100% and 120% magnification.
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8.3.18.  Size

Choose to give your PZN barcode a Small, Normal or Large size. Those are predefined sizes
for this barcode. The actual Height, Characters per unit, Ratio and Narrow Bar values are
shown underneath.

By selecting Custom, you can manually edit these four parameters.

8.3.19.  Height

Enter the height to give to your barcode's bars. They need to be tall enough to be read easily by
barcode scanners.

Code 128
In Dynamic Barcodes, you can create Code 128 barcodes shorter than the minimum height.
Dynamic Barcodes will just display a warning, but if you export the document to EPF and open
it in PackEdge, PackEdge will extend the barcode to its minimum required height.

 

 

Bars and Digits
For:

• EAN 8 & 13
• HIBC 128 and 39
• M+S 7, and Marks & Spencer's
• NDC / HRI
• UPC-A and UPC-E

For the bar codes listed above, the height you enter is the combined height of the bars and
the human readable characters). Your barcode needs to be tall enough to be read easily by
barcode scanners.

Attention:  Do not change the Height of the barcode before entering a Magnification
value. The Height will change again according to the Magnification factor you define.

8.3.20.  Characters per unit

This parameter allows you to define your barcode's width based on the encoding of (numeric
or alphanumeric) characters.

You can choose the unit to use: micron, mil (milliinches), mm or inch.

101



8 Dynamic Barcodes for Adobe Illustrator

For example, choose mm and use 1 Character per unit in the Dynamic Barcodes dialog if
you want the bars needed to encode one character to take up 1 mm.

 

 

Increase the Characters per unit value to make the barcode narrower, or decrease it to make
the barcode wider. For example, if you choose 0.5 Character per unit, the bars needed to
encode one character will take up 2 mm.

 

 

Note:  Barcodes like Interleaved 2 of 5 encode two characters together in a group of black and
white bars. For these barcodes, Dynamic Barcodes takes half of the group of black and white
bars to measure one character.
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8.3.21.  Ratio

The Ratio is the factor between the width of the narrow bar and the width of the wide bar in
your barcode. For example, enter 3 if you want your wide bar to be three times as wide as your
narrow bar.

8.3.22.  Narrow Bar

This parameter determines the width of the narrowest bar of your barcode. In some cases
(for example GS1 DataBar barcodes) this affects the size (height and width) of your barcode
proportionally.

8.3.23.  Width

This parameter determines the width of the barcode from the leftmost bar to the rightmost
bar. Changing the Width will update the Narrow Bar and Characters per unit settings to achieve
the desired size.
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The Light Margin Indicators and Box are not included.

8.3.24.  Wide Bar

This parameter determines the width of the widest bar of your barcode.

8.3.25.  Gap

Enter the width of the white space between the bars.

Note:  The Ratio influences the Gap size: increasing the Ratio also increases the Gap size.

8.3.26.  Vertical alignment

Dynamic Barcodes allows you to resize either the UPC-A or the GS1 Databar Expanded Stacked
coupon barcode, so they are aligned vertically with each other. You can choose:

• None to keep the original size of both the UPC and the GS1 barcodes,
 

 

• Resize UPC to GS1 to resize the UPC barcode so it has the same height as the GS1 barcode,
 

 

• Resize GS1 to UPC to resize the GS1 barcode so it has the same height as the UPC barcode.
 

 

8.3.27.  Snap Bars to Output Resolution

Use this to adjust the barcode size parameters (Bar Width Reduction, Device Compensation
and Magnification) so that the bars' width and height take up a complete number of pixels or
dots.
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Enable Snap Bars to Output Resolution and enter the resolution you will use to print your
barcode in ppi.

8.3.28.  Decimal Input

Use this parameter to change the type of data you can enter in the Code field.

• Disable it to enter the data to encode in binary format.

• Enable it to enter the data in decimal instead of binary format.

Note:  When using binary format for the Laetus Pharma Code/CLF-8 barcode data, you need to
use a special "Pharma" binary format.

To convert a decimal number into a Pharma binary number, do the following:

1. Add 1 to your decimal number.
2. Convert the result to a binary number using a regular binary conversion algorithm.
3. Remove the first digit (which is 1).

You now have your Pharma binary input for the Laetus Pharma Code/CLF-8 barcode.

For example, you want to encode the number 3.

1. 3+1=4
2. 4 in binary is 100.
3. Without the first digit, it's 00.

Enter 00 in the Code field of your Laetus Pharma Code/CLF-8 barcode.

8.3.29.  Add Check Digit

Use this parameter to add a check digit to your barcode data.

Note:  Code 39 doesn't usually contain a check digit but it can be required in some cases.

8.3.30.  Symbol Type

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical
cells”).
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Note:  If the number of cells you choose for your symbol is too small to encode the data you
entered in Code, Dynamic Barcodes will display an error.
 

 

You can choose Best Fit to make Dynamic Barcodes automatically adapt the number of cells to
the amount of data you entered in Code.

8.3.31.  Cell Size

Enter the size you want to give to each cell of the symbol. This affects the size of the whole
symbol.

The unit used is the one you chose as Illustrator's General unit in the Units & Display
Performance Preferences.

In the example below, the first symbol has a 1 mm cell size (cells sides are 1 mm), and the
second one a 2 mm cell size.

 

 

8.3.32.  Width / Total Height

The Width and Total Height parameters depend on the Cell Size and the number of cells used
for the symbol (Symbol Type).

In the example below, a symbol of 10 x 10 cells where each cell is 3 mm gives a Width and Total
Height of 30 x 30 mm.
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8.3.33.  Total Height

Enter the total height you want to give to your barcode. This is the combined height of the
bars, the human readable characters and the box. If your barcode doesn't contain human
readable characters or a box, the Total Height is the same as the bars' Height.

8.3.34.  Smax / Smin

Use these parameters to define the width of the printability gauges (“H” marks) either side of
your barcode. Smax defines the width of the left “H”, Smin defines the width of the right “H”.
Enter 0 in both fields if you don't want printability gauges.

In the example below, the top barcode has a value of 0 for both Smax and Smin, the middle
one has a value of 4 and the bottom one has a value of 8 (the maximum).
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8.3.35.  Box

Use this parameter to create an opaque white box under your barcode.

 

 

Use the Top, Bottom, Left and Right fields to add a white margin around your barcode and
make the box bigger.

 

 

By default, Dynamic Barcodes links the four margins' values so that when you change one of
them, the other ones are updated automatically.

 

 

If you want to change them independently, click the link symbol to make it look detached  .

For ITF, UCP and UPC-SCS bar codes, the box will be transparent, with bearer bars around it.
The Box Line Width parameter defines the width of the bearer bars.

The option Only Top and Bottom Bars limits the bearer bars to only the top and bottom line.

Note:  When creating a bar code, the current Box parameters are stored for the specific
barcode type. This means that the next time you select the same barcode type (e.g. when
creating a new barcode of that type) the Box parameters will be adjusted.
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9.  Barcode Parameters from the Job
Folder

Automation Engine stores information related to the printing jobs within the Job Folder. Each
Job Folder can hold various job-related technical information, including barcode parameters.

The following barcode parameters can be set in Automation Engine Pilot:

Parameter Note Link

Type The type of barcode. You can't have two
different bar codes of the same type in one
job.

Sub Type The size of the symbol for Datamatrix
barcodes.

Symbol Type on page
105

Code The encoded value including check digits. Code on page 95

Composite Code For barcodes with a Composite Component -
mainly GS1 Databar codes

Composite Component
on page 96

Output Resolution Snap Bars to Output
Resolution on page 104

Bar Width Reduction Bar Width Reduction on
page 100

Device Compensation Device Compensation
on page 100

Narrow Bar Main size parameter for Code 128, Code 39,
Interleaved 2 of 5, Codabar or MSI based
barcodes, for GS1 DataBar barcodes, and for
binary barcodes. For 2D barcodes such as
DataMatrix, the parameter is used to set the
Cell Size.

Narrow Bar on page
103 and Cell Size on
page 106

Magnification Main proportional size parameter for EAN and
UPC based barcodes

Magnification on page
100

Ratio Used for Int2of5 barcodes Ratio on page 103

Important:  Automation Engine does not check the parameters. All listed parameters are
available for all barcode types, even if they are not valid for the given barcode type. Make sure
you're entering the valid inputs, including a correct Code with its check digit.

Note:  It is not necessary to have the parameters already set on the Job Setup when creating
barcodes: as soon as the Job Setup contains the settings for connected barcodes, these
barcode parameters will be applied. This allows you to create templates or placeholders before
the actual data (code for the barcode, etc) is available.
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9.1.  Connecting to a Job Folder

In order to take parameters from an Automation Engine Job Folder, you need to be connected
to an Automation Engine, and open the file from the Automation Engine Job Folder. For easy
locating the file on the server, you can use File > Job Folder > Open from Job folder

For more information on how to connect to Automation Engine, and on opening from a Job
Folder, we refer to the Esko DataExchange documentation. See http://help.esko.com/products/
Esko%20Data%20Exchange%20for%20Adobe%20Illustrator

9.2.  Connect Dynamic Barcodes to Job Setup

To use the Barcode properties from the Job Folder, enable the Get Properties from Job Setup.

When enabled, the icon on the right will indicate the status:

• Gray: the feature is disabled
• Green: the connection is established
• Red: the file is not in a Job Folder, or the connection is down.
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9.3.  Use Barcode parameters from Job Setup

To use the barcode parameters from Job Setup, select a barcode type from the Barcode Type
list that is defined in the Job setup. You can recognize these barcode types by the green icon in
front.

As soon as you select one of the barcode types defined in the Job Setup, all parameters that
are defined in the job setup will be entered (and no longer be editable), indicated by the same
green icon.

111



9 Dynamic Barcodes for Adobe Illustrator

In the example above, only the Code is defined in the Job Setup. All other parameters can be
entered freely.

9.4.  Updating barcode parameters from Job Setup

If a barcode is connected to the Job Setup, any changes to the barcode parameters in the Job
Setup, whether it is a changed parameter or a newly added parameter, will automatically and
immediately be taken into account in Dynamic Barcodes.

When opening a file, all barcodes with the Get Properties from Job Setup option enabled will
be updated automatically

If a barcode type is removed from the Job Setup, the corresponding barcodes in the job will no
longer be connected, so the Get Properties from Job Setup option is disabled.

A barcode will also be disconnected and the Get Properties from Job Setup option will be
disabled in case the barcode parameters in the Job Setup are invalid for the given barcode
type. You will need to change the parameters in the Job Setup. Note that after correcting the
parameters, you need to manually reconnect the barcode by enabling Get Properties from
Job Setup.
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